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Chapter 1: Welcome to Card 
Printer Information
This manual describes the XPS Card Printer and how to use it. 

Before you use the printer, install and set up the printer. In most cases, install the 
Windows driver for the printer as part of setup. See “Install the Printer” for the 
steps to follow.

Please read this XPS Card Printer Installation and User Guide thoroughly before 
you use the printer.

Each card program has specific features, and it is important for you to understand 
the features of your card program. Talk with your supervisor, system 
administrator, or other person to understand the features of your card program. It 
will help you to successfully print cards using the printer.

About the Printer
Card printers are compact 
printers that apply images 
and text to plastic cards. 
The card printer can print 
full-color and monochrome 
images, depending on the 
type of print ribbon 
installed.            

There are several options 
available for the card 
printer including magnetic 
stripe, smart card, 
automatic duplex, and 
reject hopper. The configuration label on the printer can help you determine the 
options installed. See the “Printer Configuration Label ” for more information 
about the factory-installed options.
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The card printer is available with an input hopper or with a single feed slot, and 
with or without automatic duplex. Click one of the following to view the different 
options:

• “Printer with Input Hopper” 

• “Printer with Single-Feed Slot” 

• “Printer with Duplex Option” 

HINTS & TIPS

• The printer is designed to issue cards either one at a time or in batches — up 
to 100 cards at a time. An optional 200-card input hopper is available for some 
printers.

• A busy issuance site might issue up to 10,000 cards a month. 

• Often, a site will have busy times and slow times. During busy times, the site 
might use more than one printer to keep up with demand.

Printer Components

Printer with Single-Feed Slot
                                                            if
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Printer with Input Hopper
                                                            

Inside a single-feed or hopper-equipped printer
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Printer with Duplex Option
                                                            

Inside a printer with a duplex option
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Printer Configuration Label 
The printer has a label on the side of the cover 
arm that shows the components installed. Find 
the label on the side of the cover arm:

The label shows:

• Printer name, which also appears on the 
model label 

• Configuration, which includes options in the 
printer: 

• Date and country of assembly 

• The MAC address to use when the printer is connected via an Ethernet 
network 

The printer label provides information that is useful when requesting service. It 
can also help you know the components installed. Some components might be 
installed by the dealer or sales group. The information for those items should be 
hand-written on the label.
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Printer System
The card printer is used with other equipment and software to create a card 
production system. The system produces cards for a specific purpose and the 
cards must meet requirements. Ask about the requirements for cards that you 
produce, or see “Card Design and Setup” for typical requirements. 

The system can include:

1. A PC, with software to support 
the printer, such as: 

• The XPS Card Printer Driver 
for Windows. 

• ID software designed 
specifically to capture, format, 
and save the data for cards. 

• A retail application such as 
Microsoft® Word or Adobe® 
Photoshop®. 

• See “Installation 
Requirements”. 

2. Capture devices, such as: 

• A digital camera to take photos for ID badges and other cards, connected 
to the PC. 

• A signature capture pad or fingerprint reader. 

3. The printer with supplies and a facility power source. 

4. A data connection between the printer and PC, which can be a USB 
connection or a network connection. (Do not use both connections with one 
printer.) 

Tasks and Users

In most work places, more than one person uses the printer. Each person might 
use it differently.

• The Operator makes cards using the printer, loads supplies, and handles 
minor problems such as a card jam. 

• The Manager sets up the card making system, sets up card designs, and 
might identify new ways to use the card printer in the organization. 
6 Welcome to Card Printer Information



 

Information for Users

This guide provides operator information and describes how to install, use the 
printer, and perform routine tasks. 

An additional Solution Guide is available for use by Administrators or by 
professionals designing a new system for printing cards. 

When the XPS Card Printer Driver is installed, the information is also installed. 
The installation creates a desktop icon called My XPS Card Printer. Use My XPS 
Card Printer to choose the user level. This sets the type of information you view. 

Using My XPS Card 
Printer, you can also:

• Open the 
Printers Window 
to view the 
status of the 
printer and to 
view settings. 

• Print a guide on 
a paper printer. 

• Link to the web 
site. 

For Non-Windows Users

The information for the card printer can be viewed and printed from other 
operating systems, such as Linux. 

Insert the Driver CD into the PC, open a file and folder browser, and open the 
Documentation folder. Select a document to view.

My XPS Card Printer is a Windows application. It does not run on non-Windows 
operating systems.
7
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Chapter 2: Installation 
Requirements

Your installation method depends on how many users will print to 
the card printer, the operating system you will use to send card 
data and other decisions in your environment.
This section describes:

• “PC Requirements” 

• “Site Requirements” 

• “Electrical Requirements” 

• “Choosing Your Installation Method”

PC Requirements
Use a PC that meets or exceeds the following:

• A 32- or 64-bit processor, running at 1 GHz or faster 

• 2 GB or more memory (RAM) and at least 1GB free space on the hard drive 

• The following operating systems are supported: 

Windows 7, 32- or 64-bit 

Windows Vista, 32- or 64-bit 

Windows XP, 32-bit. Windows MSXML 6.0 and the Windows XPS Essentials 
pack are required to install the printer driver. The driver installer checks the 
operating system for these files and installs them if needed. 

Windows 2003 Server, 32- or 64-bit 

Windows 2008 Server, 32- or 64-bit 

• Apple® Bonjour® for Windows is required to install the printer driver. The 
driver installer checks the operating system for this application and installs it 
if needed. 

• USB 2.0 port or Ethernet network connection 

• ID software to capture and organize the data to appear on each card. 
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Network Requirements 

To install a printer on a network, the following components are required: 

• An Ethernet network that uses the TCP/IP protocol and can run at 100 
megabits per second, also called 100base-T. Printers also support 10base-T. 

• An Ethernet cable to connect the printer to the network. An Ethernet cable is 
not supplied with the printer. 

• A PC that meets the requirements listed above, that is connected to and 
communicating with the network. 

• You can connect many network printers to one PC. The maximum number of 
printers depends on the capacity of the network to deliver data to the printer. 

USB Requirements 

To install a printer using a USB connection, the following components are 
required: 

• A high speed USB port. USB 2.0 is recommended. 

• A USB cable to connect the printer to the PC. A USB cable is supplied with the 
printer. 

• A PC that meets the requirements listed above. 

• If you need to connect two card printers to a PC with one USB port, use a 
single, independently-powered USB hub to which both printers can be 
connected. 

• Up to four card printers can be connected to a PC using USB cables.
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Site Requirements
Set up and use the printer in an 
environment that meets the 
following requirements. 

• Provide space for the printer 
and for clearance around 
the printer. The printer 
dimensions and clearance 
area is shown in the table 
below.

Printer
Model

Dimensions (inches/mm)

A B C D E F G

SD260
10.00
254

8.80
224

4.00
102

6.85
174

4.00
102

15.37
390

4.00
102

SD360 with 
Smart Card

10.00
254

8.80
224

4.00
102

6.85
174

4.00
102

21.21
539

4.00
102

CD800S
10.00
254

8.80
224

4.00
102

6.85
174

4.00
102

21.21
539

4.00
102

Options such as a large output stacker and 200-card input hopper add height to the 
printer. Additional clearance is required when using these options.

                                                  
                                                  

• Place the printer in an environment with temperatures ranging from 60° F to 
95° F (15° C to 35° C). 

• Use a single phase, 3-wire, grounded receptacle. 

• Keep all dust, dirt, food, and liquids away from the printer. 

• Keep paper and foreign materials off the printer. 

• Place the printer on a sturdy, level surface. 

• Place the printer away from direct sunlight. 

• Do not place printer near heating ducts, fans, or other air vents. 

• Do not use the printer for purposes other than the intended use. 
11



 

• Prevent debris from entering the printer. 

• Place the printer in a clean office environment. 

Electrical Requirements
The power supply has earned the ENERGY STAR® and is rated as follows: 

Printer Model Electrical Requirements

SD260

110-240V/50-60 Hz/3.0 AmpSD360

CD800

The power supply detects the input voltage, and works within the range stated. 
The printer is ENERGY STAR qualified only when used with the included power 
supply. 
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Chapter 3: Install the Printer
This section provides information about installing 
the printer and driver on a PC running a supported 
Windows operating system. Printer installation 
includes preparing the printer and then installing 
the driver.
Most often, the driver is installed using the installation CD shipped with the 
printer. The driver installation procedure prompts you to power on the printer 
and when to connect cables.

Installation includes the following steps:

1. Choosing Your Installation Method

2. Prepare the Printer

• Load Cards

• Load Print Ribbon

• Load Cleaning Roller

3. Install the Printer Driver
13



 

Choosing Your Installation Method
Your installation method depends on how many users will print to the card 
printer, the operating system you will use to send card data, and other decisions 
in your environment.

The printer can be installed using one of the following installation methods:

Driver CD The printer ships with a CD in the printer carton. In most cases, 
install the driver from the CD using one of the following 
connection types: 
• USB Installation using the Installation CD
• Network Installation using the Installation CD

Download If you do not have access to the installation CD, install the driver 
from a downloaded driver file:
• USB Installation using a downloaded driver)
• Network Installation using a downloaded driver)

Printer Sharing Printer sharing allows one or more PCs (clients) to print cards to 
a printer installed on a different PC (host). The driver uses the 
built-in printer sharing capabilities of the operating system.
• Printer Sharing Requirements
• Operating Systems Supported

Printer Pooling A printer pool is a group of printers that act as one printer. Print 
jobs are sent to the pool and are distributed among the available 
printers.
• Printer Pooling Requirements
• Operating Systems Supported
• Setup a Printer Pool, Windows 7 and Windows Vista
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Connecting More Than One Printer

There are several choices for connecting more than one printer to a PC or for 
having more than one PC connected to a printer. You can connect to several 
printers installed on a network, or connect multiple printers to a PC using USB 
cables. 

Use the following guidelines to install more than one printer using USB cables: 

• Connect and install one printer at a time. The PC cannot run more than one 
installation program at a time.

• USB protocol allows devices to be connected to the PC through another USB 
device. USB protocol also uses hubs to which multiple USB devices can be 
connected. 

If you need to connect two card printers to a PC with one USB port, use an 
independently-powered USB hub to which both printers can be connected. 

• Up to four card printers can be connected to a PC using USB cables. 

• Use one powered high-speed (USB 2.0) hub. Do not daisy-chain multiple 
hubs. 

• The printer(s) must be powered on for the PC to detect it. It must remain 
powered on during installation. 

To Install Additional Printers

For each USB printer installed after the initial USB installation, follow these 
instructions: 

1. Load supplies and then power on the printer. See “Prepare the Printer” for 
the steps to follow. 

2. Log on to the PC as a user with Administrator access. 

3. Connect the printer to the PC using a USB cable. 

4. The operating system detects the new device. It might display a popup during 
installation. 

5. If the operating system does not display a popup within a few minutes, check 
the Printers window to see if the icon for the new printer is displayed. At 
times, the software installs without displaying the popup. 

6. The operating system usually uses the existing driver files to install the driver 
for this printer. Insert the driver CD only if you are prompted for it. 
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Using more than one printer on a PC

When using more than one printer on a PC, keep the following in mind: 

• Select the printer to use in the ID software or other application. Card jobs will 
be sent to the selected printer even if more than one card printer is attached to 
the PC. 

• When messages are displayed, the title bar of the message box displays the 
name of the printer causing the message. Keep track of the printer names. 

• Each printer has its own icon in the Printers window, and each printer has 
separate Properties and Printing Preferences dialog boxes. Settings are not 
shared among printers. 
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Prepare the Printer
Prepare the printer to print cards by installing supplies including blank card 
stock, print ribbon, the cleaning roller, and optional equipment. For more 
information on optional equipment, see Install Printer Options. 

Load Cards

If you are using a manual feed 
printer, skip this step and keep a 
supply of blank cards close to 
the printer. For printers with an 
input hopper, continue with 
these steps:

1. Open the input hopper (a). 

2. Fan cards before placing 
them into input hopper (b). 

Insert magnetic stripe cards 
with the stripe down and 
toward the right-hand side of the input hopper. 

3. Close input hopper (c). 

Load Print Ribbon

Load the ribbon when you install the printer 
and when the ribbon runs out. 

1. Open the printer’s top cover. 
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2. Remove the print ribbon cartridge. 

3. Load a full roll of print ribbon onto the 
spindle closest to the cartridge handle. 

4. Place the empty spool on the spindle 
with the black gear. 

5. Wind the empty spool counter-
clockwise one full turn. 

Load Cleaning Roller

Load a new cleaning roller with each 
new roll of print ribbon.

The printer ships with the cleaning 
roller spindle installed on the print 
ribbon cartridge.

1. Remove the cleaning roller spindle 
from the ribbon cartridge and slide 
the continuous cleaning sleeve 
onto the spindle (a). 

2. Snap the spindle with sleeve installed back onto the ribbon cartridge (b). 

3. Remove the protective wrapper from the cleaning sleeve (c). 
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Install Ribbon Cartridge

Install the assembled print ribbon 
cartridge into the printer.

1. Hold the print ribbon cartridge by the 
handle and lower into the printer with 
the handle toward the front of the 
printer. 

2. Check to see that the ribbon cartridge 
is correctly positioned in the guides. 

3. Close the printer cover. 
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Install the Printer Driver
This section provides information about installing the printer driver on a PC 
running a supported Windows operating system. See “PC Requirements” for a 
list of supported operating systems.

Most often, the driver is installed using the installation CD shipped with the 
printer. The driver installation procedure prompts you to power on the printer 
and when to connect cables.

Use one of the following links to view instructions about how to install the 
printer driver:

• “USB Installation using the Installation CD” 

• “USB Installation using a downloaded driver” 

• “Network Installation using the Installation CD” 

• “Network Installation using a downloaded driver” 

USB Installation using the Installation CD

1. Log on to the PC as a user with Administrator access. 

2. Insert the driver CD in the PC’s drive. The driver install window opens. 

3. Click the Install a USB Printer button.
                                                            

                                                  
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4. The driver might require additional software, and present a license agreement 
for that software.  Read the license agreement(s) presented, click the Accept 
box, and then click the blue arrow pointing to the right.

                                                            

5. Follow the steps to “Prepare the Printer”.
                                                            

                                                  

Use the green media controls to view step-by-step instructions about how to 
Prepare the Printer.

6. Click the blue arrow pointing to the right. 

7. Plug in and power on the printer. 
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8. The installer will prompt you to connect the printer to the PC using a USB 
cable.
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9. Connect the printer to the PC using a USB cable. 
                                                            

10. When installation is complete, the Print a Sample Card page appears. Check 
that “Ready” is displayed on the LCD panel and click the Print Sample Card 
button. Installation is complete when the sample card prints successfully.

                                                            

For more information on how to print a sample card or a printer test card, see 
“Print Driver Sample Cards” or “Print a Printer Test Card”.
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USB Installation using a downloaded driver

The printer ships with an Installation CD in the printer carton. In most cases, 
install the driver from the Installation CD. If you do not have access to the 
Installation CD, follow these steps:

1. Log on to the PC as a user with Administrator access. 

2. Obtain the download file on a portable storage medium, such as CD or USB 
drive, and copy it to your hard drive; by email and save it to your hard drive; 
or using a method such as the following: 

A. Browse to the Downloads area of the Web site (or the Products page for 
the printer) and choose the driver for your printer and operating system. 

B. Click the link. 

C. When the File Download dialog appears, click Save.

D. Choose a location on your PC, such as C:\Temp and click Save. 
                                                  

Your network might prevent the download or installation of this file. Ask 
your network support personnel for help when downloading this file and 
when installing the driver.

3. Browse to the location of the file saved in Step 2 on your PC. 

4. Double-click the downloaded file. The file will have a name similar to 
XPSCardPrinterDriver.exe. The card printer installer window opens. 

5. Click the Install a USB Printer button.
                                                            

6. The driver might require additional software, and present a license 
agreement for that software. Read the license agreement(s) presented, click 
the Accept box, and then click the blue arrow.
24 Install the Printer



 

                                                            

7. Follow the steps to “Prepare the Printer”.
                                                            

                                                  

Use the green media controls to view step-by-step instructions about how to 
Prepare the Printer.

8. Click the blue arrow pointing to the right. 

9. Plug in and power on the printer.
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10. The installer will prompt you to connect the printer to the PC using a USB 
cable.

                                                            

11. Connect the printer to the PC using a USB cable. 
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12. When installation is complete, the Print a Sample Card page appears. Check 
that “Ready” is displayed on the LCD panel and click the Print Sample Card 
button. Installation is complete when the sample card prints successfully.

                                                            

For more information on how to print a sample card or a printer test card, see 
“Print Driver Sample Cards” or “Print a Printer Test Card”.
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Network Installation using the Installation CD

1. Log on to the PC as a user with Administrator access. 

2. Insert the driver CD in the PC’s drive. The driver installer window opens. 

3. Click the Install a Network Printer button.
                                                            

4. The driver might require additional software, and present a license 
agreement for that software.  Read the license agreement(s) presented, click 
the Accept box and then click the blue arrow.
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5. Follow the steps to “Prepare the Printer”.
                                                            

                                                  

Use the green media controls to view step-by-step instructions about how to 
Prepare the Printer.

6. Click the blue arrow pointing to the right. 

7. Connect the printer to the network using an Ethernet cable.
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8. Plug in and power on the printer.
                                                            

9. Use the LCD panel to retrieve the printer’s IP Address. For step-by-step 
instructions, see “Retrieve the Printer IP Address”.

                                                            

10. Return to the Main menu on the LCD display. Check that “Ready” is 
displayed and the User button glows green. 
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11. The Card Printer installer opens the Printer Properties window automatically. 
When this window opens, click the Configure Port button and enter the IP 
Address retrieved in Step 9 in the Printer Name or IP Address area.

                                                            

                                                  

IMPORTANT!

In some cases, the Port Number changes when the printer’s IP address is 
entered. If a number other than 9100 is displayed in the Port Number field, 
delete the number and type 9100. The printer uses Port 9100. 
31



 

12. When installation is complete, the Print a Sample Card page appears.
                                                            

13. Check that “Ready” is displayed on the LCD panel and click the Print Sample 
Card button to verify that the installation is complete. Installation is complete 
when the sample card prints successfully.

For more information on how to print a sample card or a printer test card, see 
“Print Driver Sample Cards” or “Print a Printer Test Card”.

Network Installation using a downloaded driver

The printer ships with an Installation CD in the printer carton. In most cases, 
install the driver from the Installation CD. If you do not have access to the 
Installation CD, follow these steps:

1. Log on to the PC as a user with Administrator access. 

2. Obtain the download file on a portable storage medium, such as CD or USB 
drive, and copy it to your hard drive; by email and save it to your hard drive; 
or using a method such as the following: 

A. Browse to the Downloads area of the Web site (or the Products page for 
the printer) and choose the driver for your printer and operating system. 

B. Click the link. 

C. When the File Download dialog appears, click Save.

D. Choose a location on your PC, such as C:\Temp and click Save. 
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E. When the File Download dialog appears, click Save.

Your network might prevent the download or installation of this file. Ask 
your network support personnel for help when downloading this file or 
when installing the driver.

3. Browse to the location of the file saved in Step 2 on your PC. 

4. Double-click the downloaded file. The file will have a name similar to 
XPSCardPrinterDriver.exe. The driver installer window opens. 

5. Click the Install a Network Printer button.
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6. The driver might require additional software, and present a license 
agreement for that software. Read the license agreement(s) presented, click 
the Accept box and then click the blue arrow.

                                                            

7. Follow the steps to “Prepare the Printer”.
                                                            

                                                  

Use the green media controls to view step-by-step instructions about how to 
Prepare the Printer.

8. Click the blue arrow pointing to the right. 

9. Connect the printer to the network using an Ethernet cable.
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10. Plug in and power on the printer.
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11. Use the LCD panel to retrieve the printer’s IP Address. For step-by-step 
instructions, see “Retrieve the Printer IP Address”.

                                                            

12. Return to the Main menu on the LCD display. Check that “Ready” is 
displayed and the User button glows green. 
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13. The Card Printer installer opens the Printer Properties window automatically. 
When this window opens, click the Configure Port button and enter the IP 
Address retrieved in Step 11 in the Printer Name or IP Address area.

                                                            

                                                  

IMPORTANT!

In some cases, the Port Number changes when the printer’s IP address is 
entered. If a number other than 9100 is displayed in the Port Number field, 
delete the number and type 9100. The printer uses Port 9100. 
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14. When installation is complete, the Print a Sample Card page appears.
                                                            

15. Check that “Ready” is displayed on the LCD panel and click the Print Sample 
Card button to verify that the installation is complete. Installation is complete 
when the sample card prints successfully.

For more information on how to print a sample card or a printer test card, see 
“Print Driver Sample Cards” or “Print a Printer Test Card”.
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Retrieve the Printer IP Address

The Address Mode determines how the network address of the printer is 
assigned. The choices are DHCP and Static IP. DHCP stands for “Dynamic Host 
Configuration Protocol” and means that the network assigns the IP Address to 
the printer. Static IP means that you set the IP Address assigned by your network 
support personnel. Network support personnel can tell you whether the network 
uses DHCP or static IP addressing.

1. Begin when the LCD panel shows “Ready” on 
Line 1 of the display.

2. Press the USER button (a).

“Suspended” appears on Line 1, “Menu 
available” appears on Line 2, and the USER 
button glows amber.

3. Press the ENTER key (b).

“Main Menu” is displayed on Line 1 and 
“Maintenance” appears on Line 2.

4. Press the down arrow key (c).

“Main Menu” displays on Line 1 and “Status” is 
displayed on Line 2.

5. Press the ENTER key (d).

“Status” appears on Line 1 and “Serial Number” 
displays on Line 2.

6. Press the down arrow key two times (e).

“Status” will be displayed on Line 1 and 
“Network Status” will be shown on Line 2.

7. Press the ENTER key (f).

“Network Status” will be displayed on Line 1 and 
“Address Mode” will show on Line 2.

8. Press the down arrow key (g).

“Network Status” appears on Line 1 and “IP 
Address” is shown on Line 2.
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9. Press the ENTER key (h).

“IP Address” appears on Line 1 and the 
printer’s IP Address will be displayed on Line 2.

10. Record the printer’s IP Address (i).

11. Exit the menu system by pressing the USER 
button repeatedly until “Ready” is displayed on 
Line 1 and the USER button changes from amber 
to green.
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Printer Sharing
This section describes how to use a printer over a network using Microsoft File 
and Printer Sharing. Shared printing includes a host PC and up to ten client PCs. 
The printer is connected to a host PC with the printer driver installed. Client PCs 
print to the shared printer over a network. Client PCs do not have the same level 
of access to the printer driver as the host PC.

• Printer Sharing Requirements

• Set Up the Host PC for Printer Sharing, Windows 7, 64-bit

• Install the Driver on the Client PC, Windows 7

• Set Up the Host PC for Printer Sharing, Windows XP, 32-bit

• Install the Driver on the Client PC, Windows XP, 32-bit

• Set Up the Host PC for Printer Sharing, Windows Server 2003, 32-bit

• Install the Driver on the Client PC

• Set up the Host PC for Printer Sharing, Windows Server 2008, 64-bit

• Install the Driver on the Client PC

• Set Up the Host PC for Printer Sharing, Windows Server 2003, 32-bit

• Management Tasks at the Host PC

• Tips for Success
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Printer Sharing Requirements

Before sharing a printer over a network, the following requirements must be met:

• Each PC that will use the printer must have a working network card installed.

• Operating systems and combinations supported:

• Windows 7, 64-bit Host PC

• Windows 7, 64-bit Client PCs.

• Windows XP, 32-bit Host PC

• Windows XP, 32-bit Client PCs.

• Windows Server 2003 R2, 32-bit Host PC

• Windows XP SP3, Windows Vista, or Windows 7, 32-bit Client PCs

• Windows Server 2008 R2, 64-bit Host PC

• Windows XP SP3, Windows Vista, or Windows 7, 64-bit Client PCs

• The Host and the Client PC must be using the same type of processor, either 
32 or 64-bit.

• The Host PC must be configured and enabled for sharing.

• The Host PC must remain on, with the Windows operating system running. 

• The Host PC must grant permissions for users that will print to the shared 
printer. 
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Set Up the Host PC for Printer Sharing, Windows 7, 64-bit

1. Install the printer on the host PC:

A. See “Network Installation using the Installation CD”

B. See “Network Installation using a downloaded driver”

2. Configure the host PC for printer sharing:

A. From the Windows Start menu, open the Control Panel.

B. Select Network and Internet and then Network and Sharing Settings.

C. Click the Advanced Sharing Settings button: 

a. Set the Network Discovery to ON.

b. Set the File and Printer Sharing to ON.

c. Set the Password protected sharing to ON.

3. Enable printer sharing:

A. From the Windows Start menu, choose Devices and Printers. The Printers 
window opens.

B. Right-click on the printer and select Properties. The Printing Properties 
window opens.

C. Click on the Sharing tab to display the settings.

a. Select the "Share this printer" checkbox to enable sharing.

b. Write down the printer name or rename the printer. 

This step is important to success! The client PC installation requires 
the printer name to install the driver. 

c. Make sure that the "Render print jobs on client computers" checkbox 
has a checkmark in it.

d. Click the Apply button to apply these settings.

e. Close Printer Properties.

4. Configure security:

A. Open Printer Properties. See “Open Printer Properties”.

B. Choose the Security tab.

C. Review the Group or User Names list. If the names or group for which 
you want to specify permissions do not appear in the list, add the names 
or create a group:
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a. Choose the Add button to open the Users and Groups dialog box.

b. Click on the name and click Add. Repeat for each name to add.

c. When finished adding names, click OK. The Users and Groups dialog 
box closes.

D. In the Names list, select the name or group for which you want to specify 
permissions.

a. Select Manage this printer for the Everyone group.

b. To restrict users, remove the check from the All Print permission in 
the Everyone group and set permissions for each user.

Note: Do not use the Manage documents or the Deny checkboxes for any 
name or group.

c. Select Apply to save the change. Save changes for each name.

d. Close Printer Properties.

5. Use the tabs and settings in Printing Preferences and Printer Properties to 
reflect the card design including ribbon type, print mode, and magnetic stripe 
options. Write the settings down so you can make the same settings on the 
client PC.

Install the Driver on the Client PC, Windows 7 

The Client PC must have a user account and password that matches an account 
on the Host PC.

1. Install the driver on the client PC:

A. Login to the client PC with an account that has administrator privileges 
and matches an account on the host PC.

B. From the Windows Start menu, select Devices and Printers. 

C. Choose File> Add a printer.

D. Select Add a network, wireless, or Bluetooth printer.

E. The client driver will be installed from the host PC.

• If the printer is not discovered automatically, select "The printer that I 
want wasn't listed" entry.

• In the address bar, type the name of the Host PC and the printer name 
following this format:  \\host PC name\shared printer name.

2. Install the following support files from the driver CD, if needed.
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• Install magnetic stripe fonts if the client PCs will be processing magnetic 
stripe cards.

• Copy the printer documentation folder to each client PC. 

• Install the ID Works XPS Card Printer Plug-in, if necessary.

3. Configure the Client PC:

Settings on the client PC, such as ribbon type and print resolution, must be 
configured to match the settings of the host PC. The client PC will not 
automatically detect the type of ribbon installed in the printer; instead it will 
default to YMCKT ribbon and 300 x 300 dpi resolution. Follow these steps to 
change the default settings:

A. Set Ribbon Type:

a. Open Printing Preferences for the shared printer.

b. Click the Layout tab and then click the Advanced… button.

c. Select the type of ribbon from the Ribbon Type drop-down list.

d. Click the Apply button.

e. Close Printing Preferences.

B. Set Print Resolution:

a. Open Printing Properties for the shared printer.

b. Click the Print Mode tab.

c. Select the resolution from the Color and Monochrome drop-down 
lists.

d. Click the Apply button and then close Printing Preferences.

e. For more information about print resolution, see “Set the Print 
Resolution”.
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Set Up the Host PC for Printer Sharing, Windows XP, 32-bit

1. Install the printer on the host PC.

A. See “Network Installation using the Installation CD” 

B. See “Network Installation using a downloaded driver” 

2. Set Simple File Sharing:

A. Open Windows Explorer.

B. Click the Tools menu and select 
Folder Options…

C. Click on the View tab and scroll 
down to bottom of the Advanced 
settings list. Check the Use simple 
file sharing (Recommended) 
checkbox.

3. Enable printer sharing:

A. From the Windows Start menu, choose Settings> Printers and Faxes. The 
Printers window opens.

B. Right-click on the printer and select Properties. The Printing Properties 
window opens.

C. Click on the Sharing tab.

D. Click If you understand the risks but wnat to share printers without running the 
wizard, click here. 

E. Click Just enable Printer Sharing in the Enable Printer Sharing dialog box 
and click OK. 
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F. On the Printer 
Properties Sharing tab, 
click the "Share this 
printer" radio button to 
enable sharing.

4. Enter a printer name.

5. Write down the name of 
the Host PC.

This step is important to 
success! The client PC 
installation requires the 
printer name to install the 
driver. 

6. Click OK to save the 
settings. 

7. Configure security:

A. Open Printer Properties. See “Open Printer Properties”.

B. Choose the Security tab.

C. Review the Group or User Names list. If the names or group for which 
you want to specify permissions do not appear in the list, add the names 
or create a group.

a. Choose the Add button to open the Users and Groups dialog box.

b. Click on the name and click Add. Repeat for each name to add.

c. When finished adding names, click OK. The Users and Groups dialog 
box closes.

D. In the Names list, select the name or group for which you want to specify 
permissions.

a. Select Manage this printer for the Everyone group.

b. To restrict users, remove the check from the All Print permission in the 
Everyone group and set permissions for each user.

Note: Do not use the Manage documents or the Deny checkboxes for any 
name or group.

c. Select Apply to save the change. Save changes for each name.

d. Close Printer Properties.

E. Enable bidirectional support.
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a. Open Printer Properties and select the Ports tab

b. Confirm that the Enable bidirectional support check box is checked. 

Install the Driver on the Client PC, Windows XP, 32-bit

1. Install the driver on the client PC:

The Client PC must have a user account and password that matches an 
account on the Host PC.

A. Login to the client PC with an account that has administrator privileges 
and matches an account on the host PC.

B. From the Windows Start menu, select Printers and Faxes. 

C. Choose File> Add 
printer.

D. Click Next on the Add 
Printer Wizard window.

E. Click the “A network 
printer, or a printer 
attached to another 
computer” radio button.

F. Click Next.

G. In the Searching for 
available printers 
window, choose 
Connect to this printer and click Next.

H. Type the name of the Host PC and the shared printer name following this 
format:  \\host PC name\shared printer name.

I. Choose the shared printer from the drop-down list and then click Next . 

J. Click Yes in the Connecting to printer window.

K. In the Default printer window, click Next.

L. Click Finish to close the wizard.

2. Install the following support files from the driver CD, if needed:

• Install magnetic stripe fonts if the client PCs will be processing magnetic 
stripe cards.

• Copy the printer documentation folder to each client PC. 

• Install the ID Works XPS Card Printer Plug-in, if necessary.
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• Install the support files XPS Essential Pack and MSXML v6.

3. Configure the Client PC:

Settings on the client PC, such as ribbon type and print resolution, must be 
configured to match the settings of the host PC. The client PC cannot detect 
the type of ribbon installed in the printer; instead it default to YMCKT ribbon 
and 300 x 300 dpi resolution. Follow these steps to change the default settings.

A. Set Ribbon Type:

a. Open Printing Preferences for the shared printer.

b. Click the Layout tab and then click the Advanced… button.

c. Select the type of ribbon from the Ribbon Type drop-down list.

d. Click the Apply button.

e. Close Printing Preferences.

B. Set Print Resolution:

a. Open Printing Properties for the shared printer.

b. Click the Print Mode tab.

c. Select the resolution from the Color and Monochrome drop-down 
lists.

d. Click the Apply button and then close Printing Properties.

e. For more information about print resolution, see “Set the Print 
Resolution”.
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Set Up the Host PC for Printer Sharing, Windows Server 2003, 32-bit

1. Install the printer on the host PC.

A. See “Network Installation using the Installation CD” 

B. See “Network Installation using a downloaded driver” 

2. Enable printer sharing:

A. From the Windows Start menu, choose Settings> Printers and Faxes. The 
Printers window opens.

B. Right-click on the printer and select Properties. The Printing Properties 
window opens.

C. Click on the Sharing tab and click the "Share this printer" radio button to 
enable sharing.

D. Enter a printer name.

E. Write down the name of the Host PC.

This step is important to success! The Client PC installation requires the 
printer name to install the driver. 

F. Click OK to save the settings. 

Install the Driver on the Client PC

The Client PC can be using Windows XP, Windows Vista, or Windows 7, 32-bit 
operating systems. The following instructions may be slightly different based on 
the operating system of the client PC.

1. Install the driver on the client PC:

The Client PC must have a user account and password that matches an 
account on the Host PC.

A. Login to the client PC with an account that has administrator privileges 
and matches an account on the host PC.

B. From the Windows Start menu, select Printers and Faxes. 

C. Choose File> Add printer.

D. Click Next on the Add Printer Wizard window.

E. Click the "A network printer, or a printer attached to another computer" 
radio button.

F. Click Next.
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G. In the Searching for available printers window, choose Connect to this 
printer and click Next.

H. Type the name of the Host PC and the shared printer name following this 
format:  \\host PC name\shared printer name.

I. Choose the shared printer from the drop-down list and then click Next . 

J. Click Yes in the Connecting to printer window.

K. In the Default printer window, click Next.

L. Click Finish to close the wizard.

2. Install the following support files from the driver CD, if needed:

• Install magnetic stripe fonts if the client PCs will be processing magnetic 
stripe cards.

• Copy the printer documentation folder to each client PC. 

• Install the ID Works XPS Card Printer Plug-in, if necessary.

• Install the support files XPS Essential Pack and MSXML v6.

3. Configure the Client PC:.

Settings on the client PC, such as ribbon type and print resolution, must be 
configured to match the settings of the host PC.

A. Set Ribbon Type:

a. Open Printing Preferences for the shared printer.

b. Click the Layout tab and then click the Advanced… button.

c. Select the type of ribbon from the Ribbon Type drop-down list.

d. Click the Apply button.

e. Close Printing Preferences.

B. Set Print Resolution:

a. Open Printing Properties for the shared printer.

b. Click the Print Mode tab.

c. Select the resolution from the Color and Monochrome lists.

d. Click the Apply button and then close Printing Properties.

e. For more information about print resolution, see “Set the Print 
Resolution”.
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Set up the Host PC for Printer Sharing, Windows Server 2008, 64-bit

1. Install the printer on the host PC.

A. See “Network Installation using the Installation CD” 

B. See “Network Installation using a downloaded driver”

2. Configure the host PC for printer sharing:

A. From the Windows Start menu, open the Control Panel.

B. Select Network and Internet and then Network and Sharing Settings.

C. Click the Advanced Sharing Settings button. 

a. Set the Network Discovery to ON.

b. Set the File and Printer Sharing to ON.

c. Set the Password protected sharing to ON.

3. Enable printer sharing:

A. From the Windows Start menu, choose Devices and Printers. The Printers 
window opens.

B. Right-click on the printer and select Properties. The Printing Properties 
window opens.

C. Click on the Sharing tab to display the settings.

D. Select the "Share this printer" checkbox to enable sharing.

E. Name the printer.

F. Write down the name of the printer.

This step is important to success! The Client PC installation requires the 
printer name to install the driver.

G. Make sure that the "Render print jobs on client computers" checkbox has a 
checkmark in it.

H. Click the Apply button to apply these settings.

I. Close Printer Properties.

4. Configure security:

A. Open Printer Properties. See "Open Printer Properties".

B. Choose the Security tab.
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C. Review the Group or User Names list. If the names or group for which 
you want to specify permissions do not appear in the list, add the names 
or create a group.

a. Choose the Add button to open the Users and Groups dialog box.

b. Click on the name and click Add. Repeat for each name to add.

c. When finished adding names, click OK. The Users and Groups dialog 
box closes.

D. In the Names list, select the name or group for which you want to specify 
permissions.

a. Select Manage this printer for the Everyone group.

b. To restrict users, uncheck the All Print permission in the Everyone 
group and set permissions for each user.

Note: Do not use the Manage documents or the Deny checkboxes for any 
name or group.

c. Select Apply to save the change. Save changes for each name.

d. Close Printer Properties.

5. Use the tabs and settings in Printing Preferences and Printer Properties to 
reflect the card design including ribbon type, print mode, and magnetic stripe 
options. Write the settings down so you can make the same settings on the 
client PC.

Install the Driver on the Client PC 

The Client PC can be using Windows 7 or Windows Vista, 32-bit operating 
systems. 

1. Install the driver on the client PC:

The Client PC must have a user account and password that matches an 
account on the Host PC.

2. Login to the client PC with an account that has administrator privileges and 
matches an account on the host PC.

3. From the Windows Start menu, select Devices and Printers. 

4. Choose File> Add a printer.

5. Select Add a network, wireless, or Bluetooth printer.

6. The client driver will be installed from the host PC.
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• If the printer is not discovered automatically, select "The printer that I want 
wasn't listed" entry.

• In the address bar, type the name of the Host PC and the shared printer 
name following this format:  \\host PC name\shared printer name.

7. Install the following support files from the driver CD, if needed:

• Install magnetic stripe fonts if the client PCs will be processing magnetic 
stripe cards.

• Copy the printer documentation folder to each client PC. 

• Install the ID Works XPS Card Printer Plug-in, if necessary.

8. Configure the Client PC:

Settings on the client PC, such as ribbon type and print resolution, must be 
configured to match the settings of the host PC. The client PC will not 
automatically detect the type of ribbon installed in the printer; instead it will 
default to YMCKT ribbon and 300 x 300 dpi resolution. Follow these steps to 
change the default settings:

A. Set Ribbon Type:

a. Open Printing Preferences for the shared printer.

b. Click the Layout tab and then click the Advanced… button.

c. Select the type of ribbon from the Ribbon Type drop-down list.

d. Click the Apply button.

e. Close Printing Preferences.

B. Set Print Resolution:

a. Open Printing Properties for the shared printer.

b. Click the Print Mode tab.

c. Select the resolution from the Color and Monochrome lists.

d. Click the Apply button and then close Printing Properties.

e. For more information about print resolution, see “Set the Print 
Resolution”.
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Use the Printer from the Client PC

Users at the client PC can perform several actions, including:

• Print a card. The client sends cards to print from an application by selecting 
the printer in the application. 

• Print a card using an application and magnetic stripe fonts. The fonts are 
available on the driver CD and must be installed on the client PC. When 
printing from an application such as Microsoft Word, text for magnetic stripe 
encoding can be formatted using the magnetic stripe fonts. See “Use 
Magnetic Stripe Fonts” for more information. 

• Change card design settings. Selecting a landscape or portrait card orientation 
is one of the settings that can be changed from the client PC. Many settings are 
read from the host PC and cannot be changed from the client PC. The Always 
use best possible resolution setting is not available from the client PC.

• Pause or delete print jobs submitted from the Windows Print Manager. Client 
PC print jobs can be paused or deleted from the Print Manager. The card job 
remains in the print queue until it is sent to the printer. See Windows help for 
information on using Print Manager.

• The printer status and card count information shown in Printer Properties are 
not available at the client PC. Use the options in Printer Manager to view card 
counts and printer status of the shared printer. See “Open the Printer 
Manager” for more information.

Management Tasks at the Host PC

The user at the host PC has more control over the printer and more information 
about the printer. This section describes some tasks performed at the host PC.

• Manage all jobs in the print queue. Use the Windows Print Manager to view 
all jobs in the print queue and to pause or delete any jobs in the print queue. 
The job remains in the print queue until it has been sent to the printer. 

• See and respond to messages. A message window is displayed on the host PC 
if the printer is not able to process and print a card.

• View printer status and set values using the Printing Preferences dialog box. 

• Use all features of the Printing Preferences, Properties, and Printer Manager.
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Tips for Success

• Error messages are displayed differently depending on the permissions set 
for the user’s account. Accounts with Manage Printer permissions will receive 
an error message.  The message displays the printer name in the title bar and 
a description of the error. The message window also contains a Retry and a 
Cancel button.

• The Cancel button will dismiss the error message and clear the error at the 
printer. If the error is corrected using the LCD screen, the error message on 
the PC will automatically close.

• Accounts with Print permissions can view error messages from the Windows 
Print Manager. The message will appear in the Status column of the Print 
Manager on client PCs. The print job with the error can be deleted from the 
Print Manager; however, the error must be cleared at the printer. Clearing the 
error at the LCD screen will automatically remove the error message from the 
Print Manager.

• The printer status and card count information shown in Printer Properties may 
not be available on client PCs.  Use the options in the Printer Manager 
to view card counts and printer status if needed.  See “Open the 
Printer Manager” for more information.
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Printer Pooling
A printer pool treats a group of printers as one printer and distributes print jobs 
among the available printers. Printer pooling is used in card production 
environments in which an application prints to a group of printers. The user 
chooses to print to the pool and the pool distributes the print jobs to the next 
available printer. 

• “Printer Pooling Requirements”

• “Operating Systems Supported” 

• “Setup a Printer Pool, Windows 7 and Windows Vista”

• “Setup a Printer Pool, Windows XP and Windows Server 2003 (32-bit)”

• “Setup a Printer Pool, Windows Server 2008, 64-bit”

• “Tips for Success”

Printer Pooling Requirements

• All printers in the pool must be the same model with the same features 
installed.

• Interactive mode print jobs such as smart card processing or magnetic stripe 
read commands cannot be processed on printers belonging to a printer pool. 
These features require a printer to PC direct connection.

• All printers should have the same type of supplies installed and the same 
settings applied.

• Use the settings in Printer Manager to set magnetic stripe values for each 
printer and for the printer pool. Set all printers and the printer pool to the 
same values. See “Open the Printer Manager” for more information.

• All printers must be connected using an Ethernet cable. Printer pooling is not 
supported for USB-connected printers.

Operating Systems Supported

Printer pooling is supported on all driver-supported operating systems. For more 
information on supported operating systems, see “PC Requirements”.
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Setup a Printer Pool, Windows 7 and Windows Vista

1. Install the printer:

A. To install the printer using the driver CD, see “Network Installation 
using the Installation CD”

B. To install the printer using a downloaded driver, see “Network 
Installation using a downloaded driver”.

2. Connect each printer that will be included in the pool to the network using an 
Ethernet cable. 

3. Write down the IP address of each printer. See “Retrieve the Printer IP 
Address”for the steps to follow.

4. Configure for Printer 
Pooling:

A. Open Printer 
Properties. For more 
information see “Open 
Printer Properties”.

B. Click the Add Port… 
button on the Ports 
tab.

C. Click once on the Standard 
TCP/IP Port to select it and 
then click the New Port... 
button.

D. Click Next.
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E. Type the IP address of one 
of the unassigned printers.

F. Enter a name in the Port 
Name field. Enter a name 
such as XPS Pool Printer 2.

G. Click Next.

H. Click Finish to complete 
the wizard.

I. Repeat these steps for each 
printer that will be added 
to the pool.

J. Click Close when all printers and ports have been added.

5. Enable printer pooling:

A. From the Properties> 
Ports tab, make sure 
there is a check in the 
box next to the original 
printer port. Click once 
on the original printer 
port and check the 
Enable Printer Pooling 
checkbox.

B. Check the boxes next to 
the ports added in Step 4.

C. Click Apply to save the 
settings.

6. Close Printer Properties.
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Setup a Printer Pool, Windows XP and Windows Server 2003 (32-bit)

1. Install the printer:

A. To install the printer using the driver CD, see “Network Installation 
using the Installation CD”

B. To install the printer using a downloaded driver, see “Network 
Installation using a downloaded driver”.

2. Connect each printer that will be included in the pool to the network using an 
Ethernet cable. 

3. Write down the IP address of each printer. See “Retrieve the Printer IP 
Address” for the steps to follow.

4. Configure for Printer Pooling:

A. Open Printer 
Properties. For more 
information see “Open 
Printer Properties”.

B. Click the Add Port… 
button on the Ports tab.

C. Click once on the Standard 
TCP/IP Port to select it and 
then click the New Port... 
button.

D. Click Next.
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A. Type the IP address of 
one of the unassigned 
printers.

B. Enter a name in the 
Port Name field. Enter 
a name such as Pooled 
Printer 2.

C. Click Next.

A. Choose Custom in the 
Additional Port 
Information Required 
window and then click Next.

B. Click Finish to complete the Add Port wizard.

C. Repeat these steps for each printer that will be added to the pool.

D. Click Close when all printers and ports have been added.

5. Enable printer pooling:

A. From the Properties> 
Ports tab, make sure 
there is a check in the 
box next to the original 
printer port. Click once 
on the original printer 
port and check the 
Enable Printer Pooling 
checkbox.

B. Check the boxes next to 
the ports added in Step 
4.

C. Click Apply or OK to 
save the settings.

6. Close Printer Properties.
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Setup a Printer Pool, Windows Server 2008, 64-bit

1. Install the printer:

A. To install the printer using the driver CD, see “Network Installation 
using the Installation CD”

B. To install the printer using a downloaded driver, see “Network 
Installation using a downloaded driver”.

2. Connect each printer that will be included in the pool to the network using an 
Ethernet cable. 

3. Write down the IP address of each printer. See “Retrieve the Printer IP 
Address” for the steps to follow.

4. Set up the print server properties:

A. Open the Device and Printers folder and select the printer. 

B. Click Print Server Properties 
from the menu bar.
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C. Click the Ports tab.

D. Click the Add Port… 
button.

E. Click once on the Standard 
TCP/IP Port to select it 
and then click the New 
Port... button.

F. Click Next.

G. Type the IP address of one 
of the unassigned printers.

H. Enter a name in the Port 
Name field. Enter a name 
such as Pooled Printer 2.

I. Click Next.

J. Click Finish to complete the wizard.

K. Repeat these steps for each printer that will be added to the pool.

L. Click Close when all printers and ports have been added.

5. Enable printer pooling:

A. From the Print Server Properties> Ports tab, make sure there is a check in 
the box next to the original printer port. Click once on the original printer 
port and check the Enable Printer Pooling checkbox.

B. Check the boxes next to the ports added in Step 4.

C. Click Apply or OK to save the settings.

6. Close  the Print Server Properties window.
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Tips for Success

• The name of the printer that was assigned when the XPS Card Printer Driver 
was installed will be displayed in the title bar of Error messages on the PC. 
The messages will not display the name of the printer in error.

• To locate the printer with the error condition, look at each printer in the 
pool for warning indicators or LCD messages. 

• Card jobs will be held at the printer with the error condition. All 
subsequent cards jobs will print to other printers in the pool. The printer 
with the error will not be used by the pool until the error condition is 
corrected.

• After correcting the error at the printer, resume or cancel the print job 
using the error message on the PC. Cancelling or resuming print jobs from 
the front panel will not clear the error message from the PC.

• The printer status and card count information shown in Printer Properties are 
not available to printers belonging to a printer pool. For these printers, the 
Status tab will display “Printer pooling” which indicates that the printer 
belongs to a printer pool. Use the options in Printer Manager to view card 
counts and printer status of the individual printers in the pool. See “Open the 
Printer Manager” for more information.

• The Print Sample Card and Magstripe Test Card buttons on the Printer 
Properties Status page are not available for a printer belonging to a printer 
pool. Print sample cards or test cards from the LCD panel on the printer. For 
more information on printing sample cards from the LCD panel, see “Print 
Driver Sample Cards” or “Print a Printer Test Card”.

• A printer that cannot process jobs will continue to get jobs assigned to it by 
the pool controller. The XPS Card Printer driver does not determine if each 
printer in the pool is ready to receive card jobs.

• Remove printers that are not available from the pool until they are 
functioning and ready to receive print jobs.

• To remove a printer from the pool, open Printer Properties and click on 
the Ports tab.

• Remove the check from the port assigned to the printer. 

• Some software, such as Microsoft Word, send multiple-card (batch) files as a 
single card job. In this case, the pool will send all cards in the batch to the 
same printer. ID software, or software designed specifically for card 
production, sends each card in the batch as a single print job. The printer pool 
will distribute single print jobs among the available printers. 
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Chapter 4: Printing Cards
This section explains how to:

• Print a card to a printer with an input hopper. See “Printing Cards: Printer 
with Input Hopper” for details.

• Print a card to a printer with a single feed slot. See “Printing Cards: Printer 
with Single Feed Slot” for details.

• Print on both sides of a card. See “Print on Both Sides of the Card” for 
details.

• Print a sample card. “Print Driver Sample Cards” for details.

Make sure:

• The printer system is set up. See “Printer System” for details.

• The card design is set up. See “Card Design and Setup” if you need to set up 
the design.

• Ribbon is loaded in the printer. See “Load Ribbon” for the steps to follow.

HINTS & TIPS

Make sure magnetic stripe cards are inserted correctly. The printer shows the 
correct position.

You can also print a test card from the printer. See “Print a Printer Test Card”.
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Printing Cards: Printer with Input Hopper
Make sure cards are loaded in the input hopper. See “Load Cards” for the steps 
to follow.

Printing from ID Software
1. From the ID software, use the template or 

design for this card.

2. Choose the printer if you use more than one 
printer.

3. Enter the data for this card. Follow the 
instructions for your software.

4. Capture the photo for this card, if used.

5. Click the Print button to send the card to the 
printer.

Printing from Other Software
1. Open the software application.

2. Select the XPS Card Printer as the current 
printer.

3. Use “Page Setup” to choose the “ID1” page 
size.

4. Set the margins to 0 (zero or zed).

5. Create the card design:

A. Add graphics such as a company logo or photos.

B. Add text information such as name, address, or employee number.

C. For information about additional card features, see “Card Design and 
Setup”.

6. Make sure that the input hopper contains blank cards.

7. Click Print to send the card to the printer.

HINTS & TIPS

The printer can get cards from more than one PC. It takes cards in the order 
received.
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Printing Cards: Printer with Single Feed Slot
Make sure that cards are available to insert.

Printing from ID Software
1. From the ID software, use the template or design for 

this card.

2. Choose the printer if you use more than one printer.

3. Enter the data for this card. Follow the instructions for 
your software.

4. Capture the photo for this card, if used.

5. Click the Print button to send the card to the printer.

6. At the printer, insert a card in the single feed slot.

Printing from Other Software
1. Open the software application and select the 

card printer as the current printer.

2. Use “Page Setup” to choose the “ID1” page 
size.

3. Set the margins to 0 (zero or zed).

4. Create the card design:

A. Add graphics such as a company logo or 
photos.

B. Add text information such as name, 
address, or employee number.

C. For information about additional card 
features, see “Card Design and Setup”.

5. Click Print to send the card to the printer.

6. At the printer, insert a card in the single feed 
slot.
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HINTS & TIPS

• Push the card in until the printer moves it.

• Orient all cards the same way.

• Do not touch the card surface to be printed.

• Handle cards by their edges or wear gloves.
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Chapter 5: Using the Printer
This section includes information on using the printer and driver. 
It details information on using the Front Panel and LCD Menus, 
responding to error conditions, and printer maintenance such as 
cleaning the printer.
• “Use the Front Panel”

• “Use the LCD Menus”

• “Messages and Conditions”

• “Clean the Printer”

Use the Front Panel
The front panel of the printer provides the controls you need to operate the 
printer. It includes the following:

Power switch
Use this button to power the printer off 
and on. All lights show steady amber 
while the printer powers on. 

To power off the printer, press the 
switch for 1 to 2 seconds until the 
printer powers off. 

If the printer is processing cards, you 
can press for 2 or more seconds to power the printer off immediately. You hear 
the power-down tone. Cards in the printer are not completed.

LCD panel
The LCD panel shows the printeer’s menu system and also displays printer 
messages or conditions as they are issued. See “Responding to Messages” for 
information. 

The menu system contains several choices for viewing and changing printer 
settings, and performing simple maintenance tasks such as running a cleaning 
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card or printing a test card. See “Use the LCD Menus” and “Clean the Printer” 
for more information.

User button and light
The printer has a USER button with a ring of light:

• Press the USER button to suspend the printer when it displays “Ready”. 

• Press to clear a message. 

• Press for 2 seconds or more to clear all messages. 

• Press again for 2 seconds or more to clear all cards currently printing. 

• Make sure this action is allowed in your card system. 

• The light shows whether the printer is ready, busy printing, or not available.

Off Printer is off
                                                            

Green Printer is ready
                                                            

Blinking green Printer is busy 
                                                            

Amber The printer is not ready.
The POWER button was pressed to 
turn the printer off.

                                                            

Blinking Amber The printer has an error.
                                                            

Down Arrow, Up Arrow, and Enter keys
Use the arrow keys to move through the printer menu system and the ENTER key 
to make a selection. See “Use the LCD Menus” for details. 

Ribbon Light
The ribbon light glows green when the print ribbon is low and glows amber 
when there is a problem with the ribbon, such as out of ribbon. 

 Off Ribbon is okay
                                                            

Green Ribbon is low - less than 10% 
remains
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Card Light
The card light blinks amber when the printer has a card problem, such as out of 
cards. For printers with a single-feed slot, the card light blinks green when a card 
needs to be inserted. 

Off Cards are okay.
                                                            

Green Ribbon is low - less that 10% 
remains.

                                                            

Blinking Green Insert cleaning card.
                                                            

Rapid Blinking 
Green

Insert card.
                                                            

Blinking Amber 
Green

The printer is equipped with an 
optional card present sensor and 
no card is detected.

                                                            

Blinking Amber The printer problem applies to 
cards.

                                                            

Use the LCD Menus
The front panel of the printer includes an LCD display with keys. When the 
printer is not actively printing cards, the LCD menu is available. See “Use the 
Front Panel” for more information about other features of the front panel. 

Use the menu for tasks, including:

• See “Get the Printer Network IP Address”. 

• View the printer USB IP Address. See “Get the Printer USB IP Address”. 

• View the printer serial number. See “Find the Printer Serial Number”.

• Run a cleaning card. See “Run a cleaning card”. 

• See “View Card Counts from the Printer LCD Menu”. 

Amber Ribbon is out or broken.
                                                            

Blinking Amber The printer problem applies to 
ribbon.
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• Set the IP address type. See “Set IP Address Type”. 

• Set the Magstripe Coercivity. See “Set Magnetic Stripe Coercivity”.

• Print a test card. See “Print a Printer Test Card”. 

• Change the LCD backlight. See “Change the LCD Backlight”. 

LCD Menus
The menu system has three 
major branches: 

• Use the Maintenance menu 
to run a cleaning card or a 
test card. 

• Use the Status menu to see 
settings and data about the 
printer. 

• Use the Configuration 
menu to change settings. 

HINTS & TIPS

• The menu system can be 
opened when “Ready” is 
displayed on Line 1 of the 
LCD panel. 

• The printer returns to the 
“Printer Ready” status after 
two minutes of no activity. 
Changes not applied will be 
lost. 

• To leave a selection without changing the value, press the up or down arrow 
key to scroll to Exit and then press the ENTER key. 

Messages and Conditions
When the printer cannot process the card sent, it issues a condition. Conditions 
are displayed on the LCD display on the front panel. In most cases, the driver also 
displays the condition as a message on the PC. See “Printer Driver Messages” 
for information about the messages the driver displays.

In a shared printer environment, messages may be slightly different from the 
messages and conditions described in this section. See “Printer Sharing” for 
information about messages that appear at a client PC.
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Messages on the Printer
• All messages are associated with a card job. 

• The printer displays a short description and a message number for each 
message. 

• If more than one message was issued, the next message is displayed after you 
correct the problem and click the USER button. 

• The printer issues messages that focus on recovering from problems. As a 
result, there are just a few messages. 

• If you cancel a job at the printer, the message will be removed from the PC. 
Any additional messages for the cancelled job, such as for a broken ribbon, 
will not appear on the PC. 

Messages on the XPS Card Printer Driver
• Messages displayed by the driver are similar to those on the printer. 

• Messages appear on the PC sending the card. 

• Messages might be in the background, behind the application sending the 
card. On some operating systems, the message might appear in the status bar. 
Click the icon in the status bar to open the message. 

• If more than one message was issued, the next message is displayed after you 
click the button to close the current message. 

• If you have more than one card printer installed on the PC, messages are 
displayed one at a time. The title bar of each message shows the printer name. 

• If you have more than one card printer installed on the PC and both have 
issued errors, the XPS Card Printer Driver will display the messages received 
even if you cleared the error at the printer. 

• The driver can issue messages which are not displayed on the printer front 
panel. See “Printer Driver Messages”. 
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Messages on the Printer Manager
The Printer Manager can issue messages that are displayed in a web browser 
window. Click the Continue button in Printer Manager to continue working with 
the printer. 

Other Messages
• The application you use can display messages. 

• Other printers can cause messages if more than one model of card printer is 
installed. 

• If SP or similar card printers are installed and use the 7.x driver, message 
DR00914 might be displayed. To correct this, remove the 7.x driver and install 
the 4.x Card Printer Driver.

Responding to Messages
Quick Link to a Message:

• “100: Request not supported”

• “101: Job could not complete”

• “102: Card not in position”

• “103: Printer problem”

• “104: Critical problem”

• “105: Magstripe data error”

• “106: Magstripe data not found”

• “107: Magstripe read data error”

• “108: Magstripe read no data”

• “109: Print ribbon problem”

• “110: Print ribbon out or missing”

• “111: Card not picked”

• “112: Card hopper empty”

• “113: Close cover to continue”

• “114: Cover opened during job”
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• “115: Wait for print temperature”

• “116: Magstripe not available”

• “117: Reader not available”

• “118: Print ribbon type problem”

• “119: Print ribbon not supported”

• “120: User paused the printer”

• “121: Print ribbon ID problem”

• “122: Magnetic stripe format problem”

• “123: Insert new card then continue”

• “124: Insert same card then continue” 

• “500: The printer is not available. The card cannot print.”

• “501: The printer connection was lost. Printing the card is canceled.”

• “502: The card data is missing or is not usable. The card cannot print.”

• “503: The magnetic stripe data is missing. The card cannot print.”

• “505: Bonjour is not installed. Cannot connect to the printer.”

• “506: A card is currently processing.”

100: Request not supported

To print the card:

1. Change the data to match printer features and settings.

2. Send the new card to print again.

HINTS & TIPS

• The card, if it started to print, should be discarded.

• Make sure you have chosen the correct printer in the application. Ask your 
Manager for assistance if needed.

101: Job could not complete

The card took too much time. Press the USER button on the 
printer to clear the error.

To print the card again:

1. Make sure all data for the card is available.
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2. Send the card to print again.

HINTS & TIPS

• The card, if it started to print, should be discarded.

• Make sure that data, such as a photo, is on the PC before printing. If you are 
connected to a database, verify the connection.

• Ask your Manager for assistance if needed.

102: Card not in position

The card did not reach the position for the 
next action, such as printing the card or 
ejecting the card.

1. Open the printer and remove the ribbon 
cartridge.

2. Turn the knob to move the card so the 
printer can eject it.

3. Replace the ribbon cartridge and close 
the printer.

HINTS & TIPS

• Check the ribbon to make sure it is not torn. See “110: Print ribbon out or 
missing” to fix the ribbon if needed.

• Remove any debris from the print area.

• Ask your Manager for assistance if needed.

103: Printer problem

The printer has a problem that prevents it 
from completing the card.

1. Press the printer POWER button to 
power it off.

2. Press the printer POWER button to 
power it on again.

HINTS & TIPS

• If the printer works, the problem was temporary.

• If the printer does not work, troubleshoot the problem.
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104: Critical problem

1. Press the printer POWER button or click 
OK to power the printer off.

2. Request service.

HINTS & TIPS

• The printer needs to remain off due to an internal problem.

• Pressing either the POWER button or the USER button will power off the 
printer.

105: Magstripe data error

The printer could not verify the magnetic stripe data written on 
the card. The printer encoded data on the card but could not 
verify all of the data.

To print the card again:

1. Insert a magnetic stripe card that matches the printer settings.

2. Press the USER button on the printer or click “Retry” in the Message box.

HINTS & TIPS

• The card might have been turned the wrong way.

• The card might not have a magnetic stripe.

• Send the new card to the printer.
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106: Magstripe data not found

The printer could not find magstripe written 
data on card.

To print the card again:

1. Insert a magnetic stripe card that matches 
the printer settings.

2. Position the card with the magnetic stripe 
down and to the right side of the printer.

3. Press the USER button on the printer or 
click “Retry” in the Message box.

HINTS & TIPS

• The card might not match printer settings or the data sent.

• Ask the Manager to verify that the card, the data, and the printer settings 
match.

107: Magstripe read data error

The printer could not read the magstripe 
data on the card. To read the card:

1. Insert a magnetic stripe card with data.

2. Insert the card with the magnetic stripe 
down and to the right side of the 
printer.

HINTS & TIPS

• The data might use a different format 
than the current printer setting.

• Ask the Manager to verify that the card, 
the data, and the printer settings match.
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108: Magstripe read no data

The printer did not find any magstripe data 
on the card.

To read the card:

1. Insert a magnetic stripe card with data.

2. Position the card with the magnetic 
stripe down and to the right side of the 
printer.

3. Send the new card to the printer.

HINTS & TIPS

• The card might have been turned the wrong way.

• The card might not have a magnetic stripe. 

109: Print ribbon problem

The print ribbon is not moving properly. 
To fix the ribbon:

1. Open the printer and remove the 
ribbon cartridge.

2. Fix the ribbon and move the repaired 
area one full turn.

3. Replace the ribbon cartridge and close 
the printer.

HINTS & TIPS

• Remove any debris from the print area.

• If the card is in the printer, turn the knob to move the card so the printer can 
eject it.
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110: Print ribbon out or missing

The printer does not have usable ribbon. 
Load the ribbon or replace the ribbon.

1. Open the printer and remove the ribbon 
cartridge.

2. Remove the existing ribbon and 
cleaning roller, if present.

3. Install the ribbon. Replace the cleaning 
roller.

4. Replace the ribbon cartridge and close 
the printer.

HINTS & TIPS

• Used ribbon can have “negative” images of printed data. To keep the data 
confidential, follow your policy to discard used ribbon.

111: Card not picked

The printer did not pick a card. To load cards:

1. Open the input hopper.

2. Insert cards in the input hopper. Cards can stick 
together; slide or fan cards to separate the edges 
before loading the input hopper.

3. Close the input hopper and resume printing.

4. For printers with single card feed, push the card in until the printer moves it.

HINTS & TIPS

• Orient all cards the same way.

• Do not touch the card surface to be printed:

• Handle cards by their edges

• Wear gloves
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112: Card hopper empty

The printer does not detect cards in the input hopper.

1. Open the input hopper.

2. Insert cards in the input hopper. Cards can stick 
together: Slide or fan cards to separate the edges 
before loading the input hopper.

3. Close the input hopper and resume printing.

HINTS & TIPS

• Orient all cards the same way.

• Do not touch the card surface to be printed:

• Handle cards by their edges

• Wear gloves

113: Close cover to continue 

The printer cover must be closed to print.

1. Close the cover.

2. Push down on the cover to latch it.

HINTS & TIPS

• Make sure the ribbon cartridge is installed. 

• Make sure the cartridge handle is even with the 
edges of the printer.

114: Cover opened during job 

The printer cover must be closed to print.

1. Close the cover.

2. Push down on the corners of the cover to latch it.

HINTS & TIPS

• Make sure the ribbon cartridge is installed and the 
handle is even with the edges of the printer.

• The card, if it started to print, should be discarded.
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115: Wait for print temperature 

The printer is not at the correct temperature to print the card.

Printing the card will resume on its own.

HINTS & TIPS

• The card, if it started to print, should be discarded.

• Make sure you have chosen the correct printer in the application. Ask the 
Manager for assistance if needed.

116: Magstripe not available 

Look at the “config” area of the label inside of the printer cover. Does the label 
show “M” or “J”? 

1. If yes, the printer has a magstripe option 
that is not working. Request service. 

2. If no, the printer does not have a 
magstripe option. 

3. To print the card without magstripe, 
remove magstripe data from the card and 
send it again.

HINTS & TIPS

To remove magstripe data, you might need to:

• Uncheck a box in the application.

• Change the font from “Mag Track X XPS Card Printer” to a printable font 
such as Arial, Verdana, or Calibri.

117: Reader not available

The printer does not have a reader option.

1. To print the card without using a reader option, remove the reader request 
from the card and send it again.

HINTS & TIPS

• To remove the reader request, you might need to uncheck a box in the 
application.
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118: Print ribbon type problem 

The printer cannot use the ribbon installed.

1. Use ribbon designed for this printer brand and model.

2. Check the Web site for newer firmware, which might 
support new ribbon types.

HINTS & TIPS

When the printer recognizes that a supported ribbon is installed, all enhanced 
product features are enabled and successful card printing can begin.

119: Print ribbon not supported 

The printer cannot use the ribbon installed.

1. Purchase ribbon from your dealer or authorized 
reseller.

2. Use ribbon designed for this printer brand and model.

HINTS & TIPS

• When the printer recognizes that a supported ribbon is installed, all enhanced 
product features are enabled and successful card printing can begin.

120: User paused the printer 

A person pressed the USER button on the 
printer and a card was in process.

1. The card can continue processing 
without damage.

HINTS & TIPS

• If the user pressed the button for several seconds, the card has been cancelled.

• If this message occurs often, ask your Manager or Systems Administrator to 
set the button sensitivity to a lower value.

121: Print ribbon ID problem 

The ribbon data is damaged.

1. The ribbon cannot be used. Ask your dealer or 
authorized reseller for a replacement.

2. Use ribbon designed for this printer brand and model.
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HINTS & TIPS

• When the printer recognizes that a supported ribbon is installed, all enhanced 
product features are enabled and successful card printing can begin.

122: Magnetic stripe format problem 

The magstripe data sent does not match the format set in 
the printer.

1. Ask your Manager for information about the data to 
send.

HINTS & TIPS

The printer has format settings for the data that can be encoded on the card. The 
magstripe data sent does not match those settings.

• Ask the Manager to verify that the card, the data, and the printer settings 
match.

• See Magnetic Stripe for information about data allowed for specific formats.

• Make sure fonts or escapes are used correctly.

123: Insert new card then continue 

The card requires you to insert a new card 
in the exception slot.

1. Insert the card in the printer.

2. Resume.

HINTS & TIPS

• Make sure to use the correct type of 
new card for this job.

• Do not touch the card surface to be printed:

• Handle cards by their edges

• Wear gloves

124: Insert same card then continue 

The card must be turned by hand to print the second side.

1. Turn the card over.

2. Insert the card in the printer.

3. Resume.
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Printer Driver Messages
The driver can create and display the following messages.

500: The printer is not available. The card cannot print. 

The driver cannot communicate with the printer. Make 
sure the printer is powered on and connected to the PC.

1. Connect the power cord. Use the power switch to 
power on the printer. 

2. Connect the cables from the PC to printer. 

Use either a USB cable OR a network cable, not 
both. 

3. Make sure all connections are complete. 

4. Ask network support for help, if needed.

HINTS & TIPS

• Make sure you have chosen the correct printer in the application. 

• Ask the Manager for assistance if needed.

501: The printer connection was lost. Printing the card is canceled. 

The printer connection was lost. Printing the card is 
canceled. 

To print the card, make sure the printer is powered on 
and connected to the PC.

1. Connect the power cord. Use the power switch to 
power on the printer. 

2. Connect the cables from the PC to printer. 

3. Use either a USB cable OR a network cable, not both. 

4. Make sure all connections are complete.

5. Ask network support for help, if needed. 

If this message is followed by “101: Job could not complete”, clear 
message 101 at the printer.
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502: The card data is missing or is not usable. The card cannot print. 

The driver could not use the prepared data. 

The PC did not process the data successfully. 

Make sure the data is present. Send the card to print 
again. 

If the card does not print the second time, troubleshoot 
the problem. 

A mistake in using magnetic stripe escapes or blocking 
escapes can cause this message.

503: The magnetic stripe data is missing. The card cannot print. 

The driver is set to encode magnetic stripe data only.

• The card did not contain any magnetic stripe data. 

• Make sure the magnetic stripe data is present. 

• Identify the magnetic stripe data using escapes or fonts. 
See “Use Magnetic Stripe Escapes” or “Use Magnetic 
Stripe Fonts”.

• To print on the card, change the setting in Printing Preferences to disable 
Encode Only. See “Encode Magnetic Stripe without Printing”.

505: Bonjour is not installed. Cannot connect to the printer.

• The driver uses Bonjour for Windows to 
connect to a printer using a USB cable. 

• If you previously installed a network-
connected printer and then installed a USB-
connected printer, Bonjour might not be 
installed. 

• Bonjour might have been removed from the 
PC by another program or by a user. 

To solve the problem:

• Remove the driver, using the Remove icon on the driver CD 
installer. Install the USB printer following the steps in the Quick 
Install Guide.

• Find a Bonjour for Windows download and install it. 
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506: A card is currently processing. 

The driver is currently processing an interactive 
job.

Wait until the current card is complete and then 
send the card again.
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Clean the Printer
The printer performs best when it is cleaned on a regular basis. The printer 
should be cleaned when:

• The number of cards printed since last cleaning reaches the number for your 
site

• The printer displays a message for which cleaning is a solution

• You notice debris, such as lint, on completed cards

• You install a new roll of print ribbon

Follow the cleaning guidelines for your site to keep the printer in good working 
condition.

You can perform the following cleaning tasks:

• “Run a cleaning card”

• “Clean the printhead”

Run a cleaning card
Run a printer cleaning card to clean debris from the inside of the printer. The 
cleaning card can remove most contaminants from the printer.

1. Begin with the printer powered on. 

2. Open the printer cover and remove the print ribbon 
cartridge.

3. Close the cover. The Ribbon Light will blink rapidly.

4. Open the input hopper and remove unprinted 
cards. The Card light will blink rapidly if the printer 
has the Card Present option.

5. Begin with the printer “Ready”. The USER button 
shows steady green. 

6. Press the USER button to display “Suspended” on 
Line 1 of the LCD panel. 
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7. Press the ENTER key to enter the menu system. 

8. Press the ENTER key to enter the Maintenance menu.

9. Press the ENTER key to choose Cleaning Card.

10. With Cleaning Card displayed on Line 2, press the ENTER key to display Start 
on Line 2.

11. Press the ENTER key to display “Insert Cleaning Card” in the LCD panel. The 
USER button and the Card light blink.

12. Open the cleaning card package. Place the cleaning card in 
the input area and press the USER button to start the cleaning 
cycle. 



The printer moves the card through the printer several times 
and ejects it in the output stacker. 

13. Remove the used cleaning card. Wait a few minutes for the rollers to dry.

14. Replace the cards in the input hopper.

15. Replace the cleaning sleeve with a new sleeve, and remove the protective 
cover. See “Load Cleaning Roller” for the steps to follow.

16. Replace the ribbon cartridge and close the printer. The printer is ready to 
print cards again.

17. Discard the used cleaning card and cleaning sleeve.

HINTS & TIPS

• Use the cleaning card and cleaning sleeve one time only.
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• Change the cleaning sleeve each time you clean the printer or change the print 
ribbon.

• You can also clean the printhead. See “Clean the printhead” for the steps to 
follow.

Clean the printhead
Clean the printhead when you notice unprinted lines on the finished card. This 
usually indicates dirt or contamination on the printhead. Clean the printhead 
after replacement or if it has been accidently touched. The oils from hands could 
affect print quality. 

1. Begin with the printer powered off.

2. Open the printer cover and remove the print ribbon cartridge.

3. Open the cleaning pen. 

4. Using gentle pressure, move the cleaning pen 
back and forth along the full length of the 
printhead edge until it is completely clean.

5. Replace the print ribbon cartridge and close the 
printer cover. Avoid bumping printhead when 
installing the print ribbon cartridge.

6. Power on the printer.

7. Print a sample card to verify the quality of printing.
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HINTS & TIPS

• Avoid touching the printhead edge with your fingers.

• Avoid touching the printing edge of the printhead cartridge with any sharp 
objects that can permanently damage the printhead.

• Only use the cleaning pen to clean the printhead. Other materials can stick to 
the printhead and cause damage.

• Use the cleaning pen up to 8 times, and then replace it.
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Chapter 6: Card Design and 
Setup

Card design is the name given to the combined features of the 
printed cards. Cards are useful only when all cards contain the 
required information.

Card design includes:
• The different types of data such 
as name and ID number, images 
including company logo or 
employee or other photos, and 
special features such as bar code 
or magnetic stripe. 

• The layout of the data.

• Processes to improve card life 
such as topcoat.

• Corporate style guidelines. For example, a corporate style guide can specify a 
particular shade of red for the logo.

This section describes the card design components available and provides 
detailed information about them.

• “Color Printing”

• “Monochrome Printing”

• “Topcoat Printing”

• “Card Design: Magnetic Stripe”

• “Card Design: Smart Card”

• “Printing and Non-Printing Areas”

HINTS & TIPS

• An organization might have more than one card design. For example, a health 
club can use member cards and employee ID cards.

• Print several samples of your card design and use them to evaluate the quality 
of the design.

• Use high quality (300dpi) photos and graphics.
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Card Components
The printer can personalize cards with the following components:

• “Color Printing”

• “Monochrome Printing”

• “Topcoat Printing”

• “Card Design: Magnetic Stripe”

• “Card Design: Smart Card”

• “Printing and Non-Printing Areas”

The arrangement or layout of components helps to determine how well your card 
design works for users.

The settings you choose define how the software manages the card components. 
The software you use to produce cards affects the settings available and how you 
might use them.

Color Printing
This section includes:

• “Print Ribbon”

• “Managing Color”

• “Printing Text”

• “Printing Graphics”

• “Types of Color Images”

• “Set the Print Resolution”

Print Ribbon

Color printing uses a print ribbon with 
three color panels: Y (yellow), M (magenta), 
and C (cyan). The ribbon also includes a 
black (K) panel and a topcoat (T) panel. The 
printer applies the YMC color panels to the card first, prints black components 
using the K panel, and then applies the topcoat (T), which helps protect the color 
image from damage. 
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Color print ribbon is available in full panel or short 
panel. The color area for short panel ribbon is 1.57 
inches (40mm). The YMC panels of short panel ribbon 
are approximately half the length of a full card.

When printing with short panel print ribbon, the location of the color area is 
defined in the card design. Color printing begins when the driver detects a color 
pixel and continues for the length of the ymc panels.

For more information on print ribbon, see “Supplies and Parts”.

Managing Color

Many people think that a color on the monitor and the printed color “should be 
the same.” Color management is the technical process of making color in two 
different places (such as on the PC monitor and printed on the card) as similar as 
possible. A widely used color standard is sRGB color, and the card printer also 
uses sRGB color. (sRGB is the name for the standard Red, Green, and Blue color 
space.)

Other color characteristics include brightness and contrast. The Windows driver 
includes settings to fine-tune the brightness and contrast for the card. See 
“Settings” for more information. In a non-Windows environment, color 
management or graphics software can be used to manage images.

Printing Text

The printer can print text in any color. Small characters are likely to be more 
readable if they are formatted as black and printed with the black (K) panel. The 
printer supports 6 point or larger text. with a sans-serif font such as Arial.

Printing Graphics

The printer produces full-color images from most 
types of graphics. It can use BMP, JPEG, TIFF, 
and PNG file formats for photos and logos. 

Vector graphics, such as WMF and SVG files, 
have components such as shapes with lines and 
fills. The XPS Card Printer Driver separates each 
component. Components defined as black in the 
file are likely to print with the K panel. 

For the best appearance of graphics, use a color 
that appears black but is not, so all parts of a graphic print with YMC panels. In 
the RGB color space, 0, 0, 0 is black (and prints with the K panel), but 0, 0, 5 is not 
black (and prints with the YMC panels). 
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Backgrounds that are black might print over colored images or text. Use a color 
that appears black for the background to prevent overprinting, or use white text 
over the black background. The printer uses the YMC panels of full-color ribbon 
to print grayscale graphics.

Types of Color Images

Cards can include both color photos and a color logo or text. The logo is usually 
the same on each card, and the photo is unique. Follow these guidelines to obtain 
the best results for printing both logo and photos.

• First, check the color quality of the photos:

• Change the image capture system to get the best quality photos; work 
with distance, lighting, and camera settings to obtain consistent, high 
quality photos.

• Evaluate the quality of printed photos after the image capture system is 
optimized.

• Use the Color Settings tab in Printing Preferences to adjust the printed 
output, if necessary.

• Next, evaluate the other color areas of the card, such as text or logo:

• The application might have settings that can help improve the printed 
color of text.

• Image editing applications, such as Photoshop®, can be used to change 
the color of a logo file for optimal printing.

• If the cards do not have the colors you want, ask your administrator or 
service provider for assistance.

HINTS & TIPS

• See “Card Layout” for information about different components, such as a 
logo or photo, and how to manage colors.

• See “Printing Text” in the “Monochrome Printing” topic for information 
about how the driver separates color and monochrome components for 
printing.
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Monochrome Printing
This section describes:

• “Monochrome Panels in Full-Color Ribbon”

• “Monochrome Ribbon”

• “Printing Bar Codes”

• “Printing Text”

• “Printing Graphics”

• “Set the Print Resolution”

The printer driver or application on the PC prepares the data for the printer to 
use. The type of data and the type of ribbon installed determine how the XPS 
Card Printer Driver renders it.

Monochrome Panels in Full-Color Ribbon

Full-color print ribbon includes a black 
panel. The black panel transfers to the card 
differently than the YMC panels, Text and 
bar codes are often printed with the black 
panel. It also prints any monochrome or one-
bit-per-pixel graphics using the K panel.

Monochrome Ribbon

Monochrome ribbon produces single color cards. Monochrome 
ribbon can be: 

• Alternating black and topcoat panels (KT or KTT ribbon) 

The printer applies Black and two topcoat panels on 
the same side of the card. 

• Continuous black (K ribbon)

• A continuous color, such as green or silver (also K 
ribbon) 

Continuous monochrome printing with certified ribbon 
uses the Ribbon Saver feature. The printer begins using 
ribbon at a location that corresponds to the leading edge of 
the card. The printer continues to spool ribbon for the length of the image but no 
farther. (The printer leaves a small margin between each card to avoid image 
overlap.)
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Printing Bar Codes

Bar code design is usually completed by your systems administrator and follows 
a set of standards based on the type of bar code produced. Bar codes usually 
contain a series of black lines (bars) separated by white areas (spaces). Each 
character of encoded data is represented by a set of bars and spaces. The standard 
specifies how many bars and spaces encode a character. The standard also 
specifies the minimum size of the white area, or quiet zone that surrounds the 
barcode.

To achieve the best quality printing and improve the readability of the bar code, 
the black bars should be printed using the K (black) panel of color print ribbon. 
Bar codes printed with YMC panels will not be as crisp and sharp as when 
printed with K only. 

When an application prints bar codes, the data is often sent to the printer as an 
image. The format in which the application sends the image determines how the 
driver will render the image. If the data sent is a one-bit-per-pixel image, such as 
pure black text on a white background, the driver processes it using the K panel 
of the print ribbon. If the data contains a pixel of color other than pure black or 
pure white, such as the various colors in a JPEG image, it processes the image 
using the YMC panels of the print ribbon.

The XPS Card Printer driver can be set to detect bar code data before printing and 
if discovered, proceess the data using the K panel of the print ribbon. See “Types 
of Bar Codes Detected” and “Print Bar Codes Using Monochrome”for more 
information.

Bar codes will print more successfully when you follow these guidelines: 

• Maintain the required quiet zone around the 
actual bar code. 

• Locate bar codes at least 0.25 inch (6.3mm) from 
other printing and from the edge of the card.

• Test the printed bar code in your bar code 
reader to make sure they are readable.

• Infrared readers require that the K panel be 
used to print the bar code. 

• For best results, orient the card so the bars are 
parallel to the long edges of the card, as shown. 
This orientation is the most accurate one for 
printing readable bar codes.

• Bar codes are usually more readable when they 
are printed with less power.
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Types of Bar Codes Detected

The printer driver can detect the following 1-D, 2-D, and Postal bar codes:

1-D Bar Codes: Postal Bar Codes:

• Code 11 • PostNet

• Code 39 • Planet

• Code 39 Extended • RM4SCC

• Code 93 • AustraliaPost

• Code 128 • IntelligentMail

• 2of5 Interleaved

• Codabar 2-D Bar Codes: 

• Patch Code • PDF417

• EAN 8 • Data Matrix

• EAN 13 • QR CodE

• UPC A • Micro QR Code

• UPC E

• Add 2

• Sdd 5
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Printing Text

Printing text using a K panel can make text look crisp, because only one panel is 
used for printing. Fine text is often more readable when printed with more 
power.

The font you choose also affects how easy it is to read 
printed text. The printer reliably prints 6 pt Arial font. 
Bold, sans-serif fonts are more readable after printing 
than serif fonts, or fonts with thin strokes, as shown at 
right. Fonts that print well are shown toward the top of 
the card.

When printing one-color cards, make sure text is formatted as black. Text 
formatted with a color (such as blue) in the ID software is dithered by the driver 
and characters may have a broken appearance.

Printing Graphics 

When printing one-color cards, the XPS Card Printer Driver 
dithers color and grayscale graphics. Dithering converts areas 
other than black or white to dots, so the single-color ribbon 
can approximate the lightness and darkness of the original 
graphic.

HINTS & TIPS

Monochrome means one-color. When printing cards, the opposite of 
monochrome is full-color or YMC printing.

Topcoat Printing
When a ribbon with a topcoat or “T” panel is 
installed, the printer can apply topcoat to the card 
using the printhead. Full color (YMCKT), KT, and 
KTT ribbons include topcoat panels.

Topcoat protects the printed image on the card. 
Full-color printing will fade if it lacks topcoat 
protection. Make sure that the printing is covered 
with topcoat (except for areas such as magnetic stripe, smart card, or signature 
panel).

Topcoat must be requested by the application or driver sending the card to the 
printer. When you use theXPS Card Printer Driver, it automatically requests 
topcoat for YMCKT, KT, and KTT ribbons. Most ID software also requests 
topcoat automatically.
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Topcoat should not be applied over the magnetic stripe, smart card chip, or 
signature panel of a card. To prevent topcoat application, see “Printing and 
Non-Printing Areas” for more information.

HINTS & TIPS

Topcoat is applied as an even, consistent film.
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Card Design: Magnetic Stripe
This section covers the following topics:

• “About Magnetic Stripe”

• “Magnetic Stripe Formats”

• “Use Magnetic Stripe Escapes”

• “Use Magnetic Stripe Fonts”

About Magnetic Stripe
Magnetic stripe is an option available in the printer. See 
the Printer Status page of Printer Properties for the 
printer to see if your printer has a magnetic stripe 
option. The cards you use must also have a magnetic 
stripe. The magnetic stripe is a brown or black stripe 
close to one long edge of the card.

See the package containing new cards for details about 
the magnetic stripe.

The magnetic stripe option is set up to define the 
coercivity, number of tracks, and data format. The 
coercivity and data format are set in the printer. The installer sets these values 
and they remain the same for all cards printed using the same design. See “Set 
Magnetic Stripe Coercivity” if you need to change the coercivity.

The data format determines how many characters can be encoded on a track. It 
also determines which characters can be encoded. See “Three-Track Option”to 
see the characters available with the default ISO three-track format.

See “Single-Track Option”to see the characters available with the JIS single-
track format.

Your cards can use the default format for each track, or can use a different 
combination of tracks and data formats.
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Magnetic Stripe Formats
Three-Track Option

The default data formats for a three-track magnetic stripe option are:

• Track 1 — IATA 

• Track 2 — ABA 

• Track 3 — TTS 

This combination is often abbreviated IAT. This format is called ISO format.

IATA (International Air Transport Association)

The maximum number of characters for IATA format is 76 characters. These 
characters can include spaces, upper case alphabetic characters, numeric 
characters, and the following special characters:

! # $ % ' ( ) * + , - . / ; : < @ > = ^ ] \ [ " & _

ABA (American Bankers Association) 

The maximum number of characters for ABA format is 37 characters. Numeric 
characters and the following special characters are allowed:

: ; < = >

TTS (Thrift Third Standard) 

The maximum number of characters for TTS format is 104 characters. Numeric 
characters and the following special characters are allowed: 

: ; < = >

Single-Track Option

The default data encoding format for a single-track magnetic stripe module is the 
JIS Type II format.

JIS (Japanese Industrial Standard)

The maximum number of characters for the JIS format is 69 characters. These 
characters can include spaces, numeric characters, upper case alphabetic 
characters, lower case alphabetic characters, and the following special characters:

! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ ] ^ _ ~ { | } ~
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From a PC running a Japanese edition of a supported Windows operating system 
Japanese-language characters are also supported. They include the following 
special characters: 

45 Katakana characters:

and the following 10 Katakana characters: 

Each time you start using Japanese-language characters, or stop using them, a 
hidden character is added. Each hidden character reduces the number of 
characters you can encode by one character.
104 Card Design and Setup



 

Card Design: Smart Card
• “About Smart Card”

• “Requirements”

• “Smart Card Codes on the Printer Label”

About Smart Card
This section presents basic information about personalizing smart cards. Smart 
card processing is different from other types of personalization, because the 
“smart card” step of personalization is controlled by an application that is 
different from the rest of card personalization.

Normally, smart card setup is provided by a value-added reseller or service 
provider. Information about the smart card module installed and the type of 
cards to use can be requested from your service provider or value-added reseller.

Requirements

The following items are required when personalizing smart cards:

• A direct local connection 
between the printer and the PC.

• Smart card reader in the printer. 

• A smart card cable for the smart 
card port used. The illustration 
shows the location of the smart 
card connection on the printer. 

• Card application that is customized to work with the printer and the smart 
card application (using the driver SDK or ID software application with a 
smart card application manager). 

• Smart cards that work with the reader in the printer.
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Smart Card Codes on the Printer Label

The configuration label includes codes to identify the type and model of the 
smart card module installed in the printer. The following table lists the codes 
used on the configuration label.

Code on Label Type of Smart Card Module

S1 Integrator

S2 SCM Dual Interface Reader

S3 HID PcProx Contactless

S4 iClass Read Contactless

S5 iClass Read/Write Contactless

S6 Duali Dual

The S1 value on the configuration label indicates that the printer was ordered 
from the factory with the basic smart card components installed. Basic 
components include the mounting hardware only. An integrator must install a 
contactless reader supplied by others.

If the S2 value is included in the configuration code, the printer has shipped from 
the factory with the basic components of an S1, plus the SCM Dual (Contact/
Contactless) Interface installed.
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Printing and Non-Printing Areas
The card design can have areas where printing is not allowed. Such areas include 
a magnetic stripe, signature panel, or smart card chip. ID software often manages 
such non-printing areas automatically.

If you use other applications to print cards, such as Microsoft© Word, define non-
printing areas using the XPS Card Printer Driver or escape codes. The XPS Card 
Printer Driver includes standard non-printing areas, such as three-track magnetic 
stripe and smart card chip. Both printing and topcoat are blocked in these areas.

• See “Set the Print Area” to define standard non-printing areas.

• See “Use Print Blocking Escapes” for other areas.

Standard Magnetic Stripe Area
Use the following dimensions to prevent printing in the magnetic stripe area.

The 3-track magnetic stripe is usually on the back of the card, while the single-
track magnetic stripe is usually on the front of the card. The green arrow shows 
the direction the card travels through the printer.

                                                  

A B C

3-track 3.37 in
85.6mm

1.46 in
37.1mm

0.66 in
16.8mm

2-track 3.37 in
85.6mm

1.57 in
39.9mm

0.55 in
14mm

Single-track (JIS) 3.37 in
85.6mm

1.60 in
40.6mm

0.52 in
13.2mm

Smart Card Non-printing Area
Use the following dimensions to prevent 
printing in the smart card area. The smart 
card area is usually on the front of the card. 
The green arrow shows the direction the card 
travels through the printer. 

                                                  

A B C D

0.88 in
22.4mm

1.17 in
29.8mm

0.88 in
22.4mm

1.47 in
37.3mm
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Other Areas

If you want to specify more than one area on the same side of the card or want an 
area other than the standard ones, see “Use Print Blocking Escapes”.

HINTS & TIPS

• Blocking typically extends 0.1 inch beyond the edges of a feature. The 
dimensions listed include the extended blocking region.

• Print several cards using your card design and application to verify that 
printing and topcoat are applied as you intend.

• If you do not use the driver or ID software, you can use the dimensions 
provided for smart card and magnetic stripe to customize your print and 
topcoat areas.

• Use ID software, a custom application, or escapes to define custom 
nonprinting areas for one or more of the following:

• Blocking printing but not topcoat

• Non-standard areas, such as a preprinted logo or a signature panel

• More than one area on the same side of the card

Card Layout
The arrangement or layout of components helps to determine how well your card 
design works for users. Follow these guidelines to position card design 
components for best results.

Backgrounds
• Consider using a white background for the card to achieve consistent 

professional results.

• Consider using smaller blocks of color, patterned areas, or gradients to 
highlight printed card features such as a name, photo, or logo.

• Avoid using a solid color background or half tone over a large area of the 
card. It can show flaws on the card (such as uneven surface) or the location of 
card features (such as a smart card chip).
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Image Placement
• Important images can include the photo, logo, and bar code.

• Do not place an important image on the front of the card in the same area as a 
magnetic stripe or other machine-readable feature. Frequent use of a card in a 
reader can wear away the image on the opposite side of the card.

• Do not place an important image directly on the other side of a signature 
panel. Residue from the panel can cause printing problems on an adjacent 
card. Place the image above, below, or to the side of the panel.

• Avoid uneven areas that can result in inconsistent print quality.

• Do not place an important image directly on the other side of a smart card 
chip. The card might not be as flat in that area and printing voids can occur.

Badges
If cards are used as badges, you 
might want to punch a hole or 
slot after printing so cards can be 
attached to clips. The illustration 
shows the maximum size for a 
slot. A smaller slot will be 
stronger and contribute to 
durability in the slotted area. 
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Settings
Settings are available through the XPS Card Printer Driver for Operators and 
Managers.

Managers also can use the Printer Manager to perform setup tasks.

Windows Properties and Preferences
The XPS Card Printer Driver includes the following interfaces:

• Printing Preferences, which provides card design settings, such as 
Orientation and one sided or two-sided printing. See “Open Printing 
Preferences”.

• Printer Properties, which provides status information about the printer. It 
also has port setup, permissions, and update tools. See “Open Printer 
Properties”.

Printer Manager
• The printer includes the Printer Manager, which displays information about 

the printer. The manager or installer uses it to set up the magnetic stripe 
option and to work with your service provider when troubleshooting 
problems. See “Open the Printer Manager”.

• Operators can use the printer front panel and the Properties page of the driver 
to view card counts and status information. Operators should use the Printer 
Manager only at the direction of their manager.
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Chapter 7: Printer Driver
The XPS Card Printer uses Microsoft XPS print technology to 
support printing from currently available applications. It also 
supports applications being developed using the newer 
architecture of Windows Vista and Windows 7 operating systems.
The XPS Card Printer Driver:

1. Receives card data from an application

2. Processes it for personalizing a card

3. Sends the prepared data to the printer

4. Checks the printer for card completion

5. Displays any conditions (messages) associated with the card

See “Using the driver” for tasks you can perform using the driver interfaces.

HINTS & TIPS

See the Quick Install Guide for the steps to follow to install the printer and driver 
correctly.

The installation assigns a default printer name. If you want to use a different 
name, you can change the name from the Printer (and Devices) window. If you 
have changed settings in Preferences, the settings return to default values. For 
best results, change the printer name, if needed, after installation and before 
changing settings.

Communication with the Printer
How the XPS Card Printer Driver and printer communicate:

• The printer can be connected to a PC using a USB cable or an Ethernet cable. 
For both connection types, the printer treats communication as if the PC 
(driver) is connected over a network.

• The driver requires the current printer IP address when it is connected to the 
printer over a network. See “View Network Information” for more 
information.

• When both the printer and PC use the organization's network, the network 
affects the speed of data transmission, and can affect who can use the printer.
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• When the printer and PC are connected using a USB cable, the printer and PC 
automatically set up a local network. The printer has an IP address, which can 
be used to view the Printer Manager. (See “Open the Printer Manager”.) 
Each time another card printer is connected to the PC, the local network is 
updated to include the new printer. For best results, do not connect another 
printer while using Printer Manager.

• Applications can also be customized to communicate with the printer 
through the driver. If the application you use is customized, follow 
instructions in the application.

HINTS & TIPS

• The printer can have many PCs connected to it.

• Each PC can have up to 4 printers connected using USB cables.

• Each PC can be connected to many printers over the network.

• Each printer has a separate instance of the driver.

• Each printer needs to have a different name. The driver takes care of this 
requirement.

Using the driver
The XPS Card Printer Driver provides the Windows dialogs for Printing 
Preferences for setting the page or card design, and Printer Properties to manage 
the printer in the Windows environment.

Using settings in Printing Preferences, you can:

• Adjust the colors printed (see “Adjust the Colors Printed”)

• Change card design settings (see “Change a Card Design”)

• Send cards with only mag stripe data for encoding (see “Encode Magnetic 
Stripe without Printing”)

• Print on both sides of the card (see “Print on Both Sides of the Card”)

• Rotate the card (see “Rotate the Card”)

• Set the print area (see “Set the Print Area”)

• Set the number of copies of the same card design (see “Print More Than One 
Copy of a Card”)

• Enable bar code detection (see “Print Bar Codes Using Monochrome”)
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Printer Properties provides status information and sample cards. Using Printer 
Properties, you can:

• View or set the printer network port address (see “View Network 
Information”)

• Print driver sample cards (see “Print Driver Sample Cards”)

• View printer and supplies status (see “View Printer Status”)

• View card counts (see “View Card Counts using the Driver”)

• View the driver version (see “View the Driver Version”)

• Set Windows Permissions (see “Printer Permissions”)

HINTS & TIPS

The Ports tab of the Printer Properties dialog includes an “Enable Bidirectional 
Support” checkbox. The driver always uses bi-directional communication with 
the printer. Changing the checkbox prevents all printing from the driver.
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Chapter 8: Updates, 
Upgrades, and More
This section describes: 

• “Updates”

• “Upgrades and Printer Options”

• “Deviations” 
Updates
An update replaces part of the product you have — usually software — with a 
newer release. Driver updates and firmware updates are the most common types 
of update.

• Driver Update

Driver updates are available from the website or from your service provider. 

• Firmware Update

In most cases, you should update firmware when your service provider 
recommends it. Be careful to choose a firmware file that exactly matches your 
printer type.

Updating the Driver
If a newer printer driver is released, it can be downloaded from the Web site 
listed in the bar at the bottom of the page.

Important! Do not use any of the following methods to remove or replace the existing 
driver:

• The Printer Properties > Advanced tab >New Driver button

• Delete the printer from the Printers or Hardware window.

After downloading the driver, follow the steps in “Removing a Printer from 
a Windows PC” to remove this driver and install the new one. Removing 
and installing the driver requires a user with Windows Administrator-level 
or Creator/Owner rights or permissions.

When you update the driver, the driver also updates:

• My XPS Card Printer

• The documentation folder
115



 

In most cases, software used by the driver, including an mDNS responder such as 
Bonjour®, and Microsoft components such as the XPS framework, are not 
updated.

Upgrades and Printer Options
Printer upgrades and options add functionality to your printer. Upgrades come 
with installation instructions and are designed to be installed by trained service 
providers. Printer options are usually installed by operators. 

The following upgrades and printer options are available:

• Magnetic Stripe Field Upgrade 

• Smart Card Field Upgrade 

• High-Capacity Output Hopper Option (see “Install 
a Large Output Hopper”)

• 200-Card Input Hopper Option (see “Install the 
200-Card Input Hopper”)

• Lock Option (see “Install the Lock Option”)

Deviations
Deviations are specially adapted products, created as a special-order. Most often, 
the driver or the firmware is deviated; sometimes the hardware (printer) is also 
changed. If you have a deviated driver, firmware or printer, be very careful about 
updating the driver or firmware. A deviated driver or firmware will have a 
version number with “d” near the end, similar to the following:

Firmware Version: 1.3.d1 

Driver Version: 1.0.d2 

Always check with your service provider to determine whether to install the 
update. Do not update until you are sure that the update supports the special 
features of your product.

Deviations might be called by a different name in your organization. Other 
names might include RPQ, custom, or special. RPQ stands for Request for Price 
Quotation, which is one of the first steps in developing an agreement to create the 
deviated product.
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Chapter 9: Removing a 
Printer from a Windows PC

This section includes instructions to remove the XPS Card Printer 
Driver from a Windows PC. 
If the PC is going to be used for another purpose or reason, you may want to 
remove the printer and all driver files. When the XPS Card Printer Driver is 
removed, all files associated with the driver such as printer documentation and 
magnetic stripe fonts, are also removed. 

To remove the XPS Card Printer Driver from a Windows PC:

1. Log on to the PC as a user with Administrator access. 

2. Open the Windows Printers window: 

• Windows 7, choose Start > Devices and Printers 

• Windows Vista and Windows Server 2008, choose Start > Control Panel > 
Hardware and Sound > Printers 

• Windows XP and Windows Server 2003, choose Start > Settings > 
Printers and Faxes 

3. Make sure all cards sent to the printer have printed. You cannot delete a 
printer that has jobs in the print queue. Double-click the printer icon to open 
the Print Manager and view the print jobs. If any jobs appear, do the 
following: 

A. If the job is paused and you want it to print, click the job and then choose 
Document > Resume. Wait for the jobs to complete. 

B. If you want to delete a job in the queue, click the job and then choose 
Document > Cancel. Click Yes to confirm. 

C. If the printer is paused or offline, the title bar for the window will include 
that status. Choose Printer and clear the appropriate choice to enable 
printing. 

D. To cancel all jobs, choose Printer > Cancel All Documents. Click Yes to 
confirm. 

4. Power off the printer. 
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5. Insert the driver CD into the PC’s drive.

6. Click the Remove Printer Driver icon on the main installer screen.

7. Click the Remove the Driver button.
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8. Wait until the driver is removed. The installer will show you the progress of 
the uninstall.

9. You may be prompted to restart the PC. If a restart is required, remove the 
USB cable and then click the Restart Now button. 
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Chapter 10: Troubleshooting
This section describes:

• “Tools for Troubleshooting”

• How to locate the problem (see “Locate the Problem”)

• Installation problems (see “Fixing the Printer System”)

• Card appearance problems (see “Card Appearance”)

• Magnetic stripe problems (see “Magnetic Stripe ”)

• Driver communication problems (see “Installation Troubleshooting”)

• “For Managers Only”

Tools for Troubleshooting
The tools for troubleshooting a problem are similar to the supplies and 
equipment you use to print cards:

• Cards to print, used at several stages of troubleshooting

• Print ribbon

• Cleaning supplies, especially printer cleaning cards and a cleaning pen

• The XPS Card PrinterDriver, if you use it when printing cards

• The Printer Manager, for use by managers with the guidance of your service 
provider

• Procedures to identify where a problem is occurring
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Locate the Problem

When you think the printer is not working correctly, use the following procedure 
to locate the source of the problem.

The printer, printer driver, and ID software work together to produce cards. If the 
system is not working as you expect, follow these steps, in the order listed, to 
isolate the source of the problem before contacting your service provider.

1. Check that the power cable is connected and the printer is powered on. 

2. Does the printer power on and display “Ready” on the front panel within 1 
minute?

If yes, the printer powers on. Continue to step 3.

If the printer powers on but does not display “Ready” the printer is not 
working properly; If the printer does not power on, make sure the printer is 
connected to a functioning power source.

Remove the printer power cord from the outlet.

Connect another device, such as a light, to the same outlet to verify that the 
power source functions correctly.

Connect the printer to a functioning outlet and repeat, beginning with step 1.

3. Make a printer test card. See “Print a Printer Test Card” for the steps to 
follow.

Does the test card print? Does it look like one of the cards shown in the topic?

If yes, the printer is working correctly. Continue to step 4.

If no, the printer is not working correctly. Request service for the printer.

4. Connect the printer data cable, if needed. Make sure you use the same type of 
cable – USB or network – used when the printer was installed.

5. If you use the XPS Card Printer driver, print the driver sample card. See 
“Print Driver Sample Cards” for the steps to follow.

Does the sample card print?

If yes, the printer and driver are working correctly. Continue to step 6.

If no, the printer and driver have a communication problem. Troubleshoot 
communication problems.

If you are not using the driver, ask your service provider or software provider 
for assistance.
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6. Using your ID software, print a card. Click the type of printer – with an input 
hopper or with a single-feed slot – and follow the instructions to print a card.

Does the card print?

If yes, the driver is successfully working with the ID software. Troubleshoot 
the card design.

If no, check the following:

• In the application, is the correct printer chosen in the Print Setup or Print 
dialog?

• If the printer produced a blank card, you might have the wrong page size 
or driver settings.

• If the card causes an error, the card might have a type of data the printer 
does not support.

HINTS & TIPS

This process will not help with card appearance problems. See “Card 
Appearance” for possible problems and solutions.

See “Magnetic Stripe ” if the card includes magstripe data and it causes a 
magstripe message.

Fixing the Printer System

See “Printer System” for typical components of the system. If any one 
component does not work properly, printing cards can be affected.

• The XPS Card Printer Driver

• ID Software

• Using the printer plug-in

• Other components of the system

The XPS Card Printer Driver

The XPS Card Printer Driver is provided in the CD Folder, included in the 
shipping carton. If the CD is not available, you can download the driver from the 
Web site link at the bottom of this page. Choose Support & Drivers > Drivers & 
Download from the menu. Enter your printer model in the Enter Product Name 
or Number area, and click Go.

ID Software

ID software formats the types of data used to print cards. Contact the dealer or 
distributor from whom you purchased your printer to obtain ID software.
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ID software does not know the capabilities of the printer and you are responsible 
for selecting card features that work with the printer you have.

If you do not use ID software, make sure the software you use supports the 
requirements for creating cards. If you use magnetic stripe data, you must use an 
application that saves text as text and not as a graphic. For example, MS Paint 
only saves graphic data, while Photoshop saves both graphic and text data. Fonts 
and escapes require text be sent from the application as text.

Using the Printer Plug-in

ID software might include a printer plug-in, which takes the data in the ID 
software and makes it available in the form the driver can use.

Other Components of the System

An ID or badge system usually includes a camera to take photos, and can include 
other capture devices such as those for biometric data. Using and maintaining 
these components is important to the quality of cards you produce.

Installation Troubleshooting
This section describes issues that could prevent a successful installation and the 
recommended solutions to those issues. Choose from the following topics: 

• “USB Installation Troubleshooting” 

• “Network Installation Troubleshooting ” 
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USB Installation Troubleshooting

Problem Solution

The cable is loose. Reconnect the USB cable to the ports on the PC and 
the printer. Power the printer OFF, and then back ON. 
If the PC and printer still do not communicate, restart 
the PC.

The data cable is 
damaged or frayed.

Power off the printer. Replace the cable if you have 
a spare. Contact your service provider to order a 
new data cable.

The system has a 
temporary 
communication 
problem.

USB extension cables can cause communication 
problems. The recommended USB cable is 6-ft (2 
meters) long. Be sure to use a cable rated for USB 2.0 
data transmission. 

The card printer does 
not install when the USB 
cable is connected.

If the printer is not recognized by the PC, or if 
installation was interrupted, the Device Manager 
might have an entry for the printer that needs to be 
removed before the printer can be installed.
Disconnect the printer from the PC. 
If the printer was installed, make sure it is deleted. See 
“Removing a Printer from a Windows PC” for the 
steps to follow. 
Open the Windows Device Manager. 

1. Locate the device to delete. The device might 
be called “Unknown device” or it might be 
located under the Printers or Network Adapters 
folder. The device might be marked with a 
yellow question mark or exclamation mark. 

2. Click on the device name to select it, and then 
right-click to display a pop-up menu. 

3. Choose Remove from the pop-up menu. 
4. Click Yes or OK to confirm removal of the 

device. 
5. Close the Device Manager. Close any other 

windows. 
6. Re-install the printer. See “USB Installation using 

the Installation CD”. 

I get an error message 
saying USB not 
detected.

The USB installer timed out and a printer was not 
detected.
Remove the printer driver before re-installing the 
printer.
For more information on how to remove the driver, 
see “Removing a Printer from a Windows PC”.
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The USB cable is 
connected before the 
driver is installed.

The first printer installed on a PC using a USB 
connection must be installed from the driver CD or 
downloaded driver. 
Remove the driver before re-installing the printer.
For more information on how to remove the driver, 
see“Removing a Printer from a Windows PC”.

The Print Sample Card 
button is gray.

The Print Sample Card button in the Printer Properties 
is enabled when the printer and driver communicate 
normally. If the Print Sample Card is gray, check that 
the USER button on the front of the printer is steady 
green and that “Ready” is displayed on the LCD 
panel.

The PC USB port does 
not communicate 
reliably with the printer 
USB port.

Power management on the PC has shut down USB 
communication. 
Open the Device Manager and the list of USB 
devices. Disable shutdown for each hub in the list. 
You might need to restart the PC to make the 
changes take effect.
Hibernation on a laptop PC requires several moments 
to enable USB communication. Unplug the USB 
printer port and then connect it again.
Replace the PC port or the PC. Contact your PC or 
port vendor if you need assistance.

The printer does not 
install or print on the PC 
when the PC is 
connected to a 
network using VPN 
Client software.

VPN Client software can prevent the installation and 
use of other devices. Choose one of the following 
solutions:
Connect the printer using an Ethernet cable and 
follow the instructions in “Network Installation using 
the Installation CD”. 
Disconnect the VPN Client software from the 
network, and then install the USB printer and driver or 
resume printing.

Problem Solution
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Network Installation Troubleshooting 

Problem Solution

The cable is loose. Reconnect the data cable to the network port and 
the printer. Restart the printer.

The Status page of 
Printer Properties shows 
the printer is not 
available, but the 
printer shows “Ready” 
on the LCD panel.

Follow your network troubleshooting procedures to 
isolate and test each component of the computer-
to-printer communication link.
Suggestions:
• The computer-to-network connection can be 

checked by accessing a network resource, such 
as a network drive. 

• The network administrator can check 
communication between a server and the 
printer. 

• Make sure the user is logged in to the network.

The printer is not 
configured with the 
correct network 
address

Make sure that the server name or IP address has 
been entered in the Port Settings or Configure Port 
dialog box on the computer. See“Get the Printer 
USB IP Address” for the steps to follow.
Check that “Ready” is displayed on the printer's LCD 
panel.

Driver Problems
The driver and printer can have the following communication problems: 

• “The driver does not detect the network-connected printer” 

• “The driver does not detect the USB-connected printer ” 

• “Unexpected messages appear”

• “Driver status or Windows print queue does not provide expected data”
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The driver does not detect the network-connected printer

Problem Solution

The Printer Properties > 
Status tab shows the 
printer is not available.

Make sure you are using the same type of data 
cables – USB or network – that were used when 
installing the printer. You cannot switch the type of 
data cables after installing.
Check the current Printer IP Address.
Update the IP Address on the Printer Properties > Ports 
tab.

Message 500 appears 
after you send a card 
to print.

If this happens often, consider switching from DHCP 
network addressing to Static IP addressing. See “Set 
the Driver Network Port Value” for more 
information.

The network is not 
operating properly.

Check the network using another device and fix or 
report network problems.
To check the network, print to a different (paper) 
printer or check the availability of network drives.

The printer is not 
connected to the 
network, or the PC is 
not connected to the 
network.

Make sure both ends of the data cables are 
connected. See “Data Cable”.
Replace defective cables if needed.
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The driver does not detect the USB-connected printer 

Problem Solution

The Printer Properties > 
Status tab shows the 
printer is available, but 
Message 500 appears 
after you send a card 
to print.

Make sure you are using the same type of data 
cables – USB or network – that were used when 
installing the printer. You cannot switch the type of 
data cables after installing.
Make sure both ends of the data cable are 
connected. See “Data Cable”.
Replace a defective USB cable if needed.

Message 505 appears 
after you send a card 
to print.

The Bonjour software is disabled or not installed.
Check the Windows Add/Remove Programs list to 
see if Bonjour is installed. If Bonjour is not installed and 
the printer is connected using a USB cable, the driver 
must be removed and the printer must be installed 
again.
A user with administrator (Windows XP) or Owner/
Creator (Windows Vista and 7) permissions is required 
to remove and install the printer. See the Quick Install 
Guide, available through My XPS Card Printer, for the 
required sequence.

The SD260 device was 
removed from the 
Safely Remove 
Hardware list.

Power off the printer. Wait a minute. Power on the 
printer. The device should be detected again.
The device always 
appears in the Safely 
Remove Hardware 
list.

Unexpected messages appear

When using the XPS Card Printer Driver on a PC with some older card printers 
installed, the older printer driver can display message DR00914 “The printer 
driver was not started successfully.” naming the XPS Card Printer as a printer 
that did not get installed correctly.

Clear the message. The printer works as designed. 
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Driver status or Windows print queue does not provide expected data

Problem Solution

In the print queue 
(Windows Print 
Manager), print jobs 
are shown as done and 
are removed, when 
they have not started 
in the printer.

The print queue shows jobs that Windows is still 
tracking. Those jobs can be in the queue at the 
printer, waiting for other jobs to complete

The Driver Sample Card 
or mag stripe test cards 
do not print.

The “Enable bidirectional support” choice in Printer 
Properties is unchecked. This must be checked to 
allow printing from the driver.

The Ribbon Low light on 
the printer and the 
driver status do not 
match.

The percent remaining that causes the printer Ribbon 
Low light can be set using the Printer Manager. The 
driver display cannot be changed. As a result, the 
two indicators can show different data.

In the print queue 
(Windows Print 
Manager), print jobs 
show an error and are 
removed without 
printing.

The print queue shows jobs that Windows is still 
tracking. Those jobs can be in the queue at the 
printer, waiting for other jobs to complete.

The Driver Sample Card 
or mag stripe test card 
do not print.

The “Print directly to printer” choice in Printer 
Properties is checked. Uncheck the value to allow 
printing of the driver sample cards.

A print job disappears 
from the print queue, 
but does not print.

The printer USB cable was disconnected after the 
application sent the job.

The Eject SD260 device 
appears in the Safely 
Remove Hardware list.

The USB adapter in the printer appears in the list. This 
cannot be changed.

The print job prints, but 
remains in the print 
queue.

The printer might be shared with another PC. The 
printer driver does not support sharing. Close the print 
queue and open it again to clear it.
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Card Appearance
Card appearance problems can be caused by many different factors. Click the link 
below that best describes the card appearance issue seen on the printed card.

• “Something did not print”

• “Printing includes unexpected data”

• “The color printing has flaws”

• “The printing is too light”

• “The printing in too dark ”

• “The monochrome printing has flaws ”

Something did not print

Problem Solution

Nothing is printed on 
the card. 
 
 

The magnetic stripe Encode Only option is set to On. 
Open Preferences and change Encode Only to Off.

The Print Ribbon is loaded incorrectly. Remove the 
print ribbon and install it correctly.

The page size was not set to ISO-ID1. In the 
application, use Print set up to choose the card 
printer. The correct page size will be available after 
choosing the printer. See “Printing Cards” for details.

Color printing on top of 
a black background 
does not appear on 
the card.

The printer uses the print ribbon panels in sequence; 
the Y panel prints first, then M, and so on. The black 
panel of the print ribbon is used last and will print over 
the color panels. For best results, change the 100% 
black background to a color near black, so that it 
prints using the YMC (color) panels of the print ribbon.
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Printing includes unexpected data

Problem Probable Cause Solution

Text intended for the 
magnetic stripe printed 
on the card.

The magnetic stripe 
font was not applied to 
the text.

See “Use Magnetic Stripe Fonts”.

The escape code was 
typed incorrectly.

See “Use Magnetic Stripe Escapes”. 

The text to encode was 
longer than one line.

Reduce the font size to keep all text on 
one line.

Several blank cards are 
ejected before the full 
card prints.

The application can 
use the page size in 
effect when a 
document is created, 
and you set the page 
size after creating the 
document and before 
printing.

Use the page setup feature of the 
application to set the page size before 
creating the document. Consider 
creating a template for cards that opens 
at the correct page size. 

The color printing has flaws

Problem Probable Cause Solution

One or more unprinted 
lines appear on the 
card.

The printhead is dirty or 
damaged. 

Clean the printhead. See “Clean the 
Printhead”.

One color panel is not 
aligned correctly with 
other color panels. 

The cards are slipping 
in the track. 

Run a cleaning card. See “Run a 
Cleaning Card”. 

The cards are not the 
correct size for the 
printer. 

Use cards that meet the size requirement 
for the printer. See “Cards” for 
specifications. If you must use the cards 
you have, ask your manager for help. 

Part of the printed 
image is a different size 
than on the monitor. 

Applications and 
operating systems can 
handle scaling 
differently. The PC is set 
to use a display setting 
other than 100 percent. 

For best results, use an image-editing 
program to create the correct size image 
for the card. Use a screen resolution to set 
the size of icons and text on the monitor. 
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Printing is blurred. The cards have a 
matte, not glossy, finish. 

Use cards that meet the requirements for 
the printer. See “Cards” for specifications. 

The rollers are dirty. Run a cleaning card. See “Run a 
Cleaning Card”. 

The printhead is dirty. Clean the printhead. See “Clean the 
Printhead”. 

The printed card has 
small unprinted areas.

Unprinted cards have 
scratches.

Handle cards carefully. See “Card 
Quality Guidelines”.

The printed card has 
small unprinted areas.

Cards have 
embedded particles, 
an uneven surface, or 
the card edge has 
burrs.

Use cards that meet the requirements for 
the printer. See “Cards” for specifications

The rollers are dirty or 
the card packaging 
contains debris.

Run a cleaning card. See “Run a 
Cleaning Card”. If needed, obtain a 
different supply of cards.

Part of the printed 
image is discolored.

Cards might have 
fingerprints or other dirt 
on them.

Handle cards carefully. See “Card 
Quality Guidelines”.

A signature panel is 
located on the other 
side of the card.

Design the card to avoid printing photos 
over signature panel residue.

The rollers are dirty or 
the card packaging 
contains 
contamination.

Run a cleaning card. See “Run a 
Cleaning Card”. Use cards that meet the 
requirements for the printer. See “Cards” 
for specifications. If needed, obtain a 
different supply of cards.

Problem Probable Cause Solution
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The printing is too light

Problem Probable Cause Solution

Photos look faded. The image capture 
system needs 
adjustment.

Color settings might not be optimal.
See information for the image capture 
system.
Change color settings. See “Adjust the 
Colors Printed”.

The printing is very light. The ribbon is loaded 
incorrectly.

Load the print ribbon correctly. See “Load 
Ribbon”.

The card was 
previously printed and 
has topcoat on it.

Print only new cards. See “Cards” for 
specifications.

The printhead is not 
installed correctly.

Contact your service provider for 
instructions on installing the printhead 
correctly.

The printing in too dark

Problem Probable Cause Solution

The card shows wrinkles 
in darkly colored areas. 

The card includes very 
dark areas. 

Change the design to use smaller areas of 
dark color. 

The printhead is not 
aligned correctly.

Contact your service provider.

All color printing is 
darker than intended.

Color adjustment is too 
dark. Using different 
card stock changes 
the appearance of 
printed cards.

Change the color adjustment settings. 
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The monochrome printing has flaws

Problem Probable Cause Solution

Text has broken (partly 
printed) characters. 

The monochrome (K) 
power setting is 
balanced to print both 
fine text and bar 
codes.

If the card does not include a bar code, 
increase the monochrome intensity. If the 
card includes fine text and bar codes, 
change the text to improve printing. See 
“Monochrome Printing”. 

The text is formatted to 
print with color, and 
the card is being 
printed with 
monochrome ribbon.

Contact your service provider. Format 
text to print black so the text is not 
dithered.

Printing is uneven or is 
missing in some areas.

The monochrome (K) 
power setting is too 
low. The cards require 
a different setting.

Increase the monochrome intensity. Find 
a balance between printing all card data 
and causing wrinkles.

A black-and-white 
image prints using the 
color panels.

The Windows Picture 
Print Wizard or Picture 
and Fax Viewer is 
printing the file. Many 
applications use the 
Windows tool to 
preview and print 
graphics. The tool does 
not render to true black 
and white.

Use another application, such as ID 
software or MS Word, to create the card.
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Magnetic Stripe 
To begin troubleshooting a magnetic stripe problem, first print a magnetic stripe 
sample card from the driver. See “Print Driver Sample Cards” for the steps to 
follow.

The printer uses the coercivity set using the LCD panel or Printer Manager, and 
uses the data format set using the Printer Manager. 

Problem Solution

Cards are not loaded 
correctly. 

Load cards with the magnetic stripe down and 
toward the right side of the printer. See “Load 
Cards”. 

Cards do not have a 
magnetic stripe. 

Load magnetic stripe cards in the card cartridge. If 
the cards have a magnetic stripe, check the quality 
of the cards. Change card stock if needed. 

The card has dirt or 
damage on the 
magnetic stripe. 

Encode and print the card again. If the message 
appears again, run a cleaning card to clean the 
mag stripe head. 

The magnetic stripe on 
the card is low 
coercivity material and 
the High Coercivity 
setting is selected. 

To use the cards you have, select low coercivity 
encoding. To encode with high coercivity, obtain 
cards manufactured for high coercivity encoding. 
See “Print a Printer Test Card”. 

Message 106 is 
displayed. 
The magnetic stripe on 
the card is high 
coercivity material and 
the Low Coercivity 
setting is selected. 

To use the cards you have, select high coercivity 
encoding. To encode with low coercivity, obtain 
cards manufactured for low coercivity encoding. 

The data for this job 
includes characters not 
allowed by the 
magnetic stripe format 
selected for the track.

Cancel the current print job. Make sure you know 
what data is allowed on the track. Change the data 
to be encoded, and resend the print job. 
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For Managers Only
The Printer Manager provides access to settings that you can use when setting up 
card designs, and access to troubleshooting tools. See the Solution Guide, 
available to users who choose “Advanced” on My XPS Card Printer, for 
information about using the Printer Manager. See “Open the Printer Manager” 
to access the printer manager. 

In most cases, you can perform advanced troubleshooting with the guidance of 
your service provider. 

The magnetic stripe 
data was sent in an 
encoding format not 
supported by the track. 

Check the encoding format setting for the tracks by 
using Printer Manager. See “Open the Printer 
Manager”. 
Make sure the application is using the selected 
encoding format for the track.
If the application and track are set to the same 
format, and the message appears repeatedly, 
contact the application provider for assistance.

The application sent 
track data for a track 
not supported by the 
magnetic stripe 
module.

Check the type of magnetic stripe option in the 
printer. See “Printer Configuration Label ” to 
understand the options in your printer.
If the printer label indicates a 3-track ISO module, you 
can send data for tracks 1, 2, and 3.
If the printer label indicates a single-track JIS module, 
you can send data for track 1.
The magnetic stripe option and cards must be 
capable of accepting and encoding each track of 
data the ID software sends.

Problem Solution
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Chapter 11: Supplies and 
Parts
This section describes the supplies used with the printer and parts for the printer. 
It includes:

• “Print Ribbon ”

• “Cards”

• “Cleaning Supplies”

• “Replacement Parts”

• “Cables used with the Printer”

Print Ribbon 
Print ribbon kits are available from your dealer. Kits include a print ribbon, a 
cleaning card, and a replaceable cleaning sleeve. For best results, run a cleaning 
card and replace the cleaning sleeve with each new print ribbon.

Color Print Ribbon

Color print ribbon is available in either full 
panel or short panel options. Use full panel 
print ribbon when the card design calls for 
color printing on the entire card. Short panel print ribbon is for use when only a 
portion of the card design calls for color. For example, a card design may have a 
color photo on the top or left of the card, and black text on the bottom of the card.

The color area for short panel ribbon is 1.57 inches 
(40mm). The YMC panels of short panel ribbon are 
approximately half the length of a full card. 

When printing with short panel print ribbon, the location of the color area is 
defined in the card design. Color printing begins when the driver detects a color 
pixel and continues for the length of the ymc panels. When using short panel 
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ribbon, check Printing Preferences to make sure that the selection 'Front side 
rotate image 180 degrees' is disabled. 

Both full panel and short panel print ribbons use the following color panels: Y 
(yellow), M (magenta), C (cyan/blue), K (black), and T (topcoat, clear).

The following color print ribbon kits are available:

• YMCKT Color Ribbon, 250 images per roll

• YMCKT Color Ribbon, 500 images per roll

• ymcKT (short panel) Color Ribbon, 650 images per roll

• YMCKT-K Color Ribbon, 375 images per roll

• YMCKT-KT Color Ribbon, 300 images per roll

Monochrome Print Ribbon

A monochrome ribbon prints the entire card in one color.

Monochrome ribbon can be:

• Alternating black and topcoat panels (KT or KTT ribbon) 

• Continuous black (K ribbon)

• A continuous color, such as red or silver

A roll of certified monochrome ribbon enables the Ribbon Saver feature in the 
printer. Ribbon Saver can increase the number of cards printed with each roll of 
ribbon.

The following ribbon kits are available:

• Alternating black and topcoat panels (KT ribbon), 1000 
images per roll

• Black with two topcoat panels (KTT ribbon), 650 images per roll 

The printer applies Black and two topcoat panels on 
the same side of the card.

• Continuous black (K ribbon), up to 500 images per roll
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• Continuous black (K ribbon), up to 1500 images per roll

• Continuous dark blue, up to 1500 images per roll

• Continuous gold, up to 1500 images per roll

• Continuous gold metallic, up to 1500 images per roll

• Continuous red, up to 1500 images per roll

• Continuous white, up to 1500 images per roll

• Continuous green, up to 1500 images per roll

• Continuous silver, up to 1500 images per roll

• Continuous silver metallic, up to 1500 images per roll

• Continuous scratch-off, up to 1500 images per roll

Print Ribbon Storage Guidelines

• Store print ribbon in the original package until you load it in the printer.

• Keep the original packaging closed.

• The print ribbon maintains its quality for about one year. For optimum card 
quality, purchase and store quantities that can be used within one year.

• The print ribbon and card stock might require secure storage and tracking. 
Follow your policy for storing and tracking the supplies used to make cards.

• Choose a location away from direct sunlight, with a temperature between 32° 
F and 77° F (0° C and 25° C). A humidity range from 40% to 60% non-
condensing is recommended.

• Supply rolls should be at room temperature when installed in the printer. If 
supplies are stored in an environment that is cooler than the printer 
environment, allow supplies to reach room temperature before using.

• If the printer will not be used for an extended period, remove supplies from 
the printer and store them with new supplies.

Cards
This section describes the cards to use with the printer. For best results, use high-
quality cards that meet the specifications and recommendations described in this 
section.
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Card Size

Use ISO ID-1 size cards, also called CR80 cards. Such cards have the following 
dimensions:

• 3.37 inches long by 2.125 inches wide (85.60mm long x 53.98mm wide).

• 0.010 to 0.030 inches thick (0.254 to 0.762mm thick)

For encoding magnetic stripe, use cards:

• 3.37 inches long by 2.125 inches wide (85.60mm long x 53.98mm wide).

• 0.010 to 0.030 inches thick (0.508mm to 0.762mm thick)

Actual card thickness can vary by up to ten percent from the sizes listed. 
Typically, card bow must be less than the thickness of the card. 

Card Material

Use cards with a glossy PVC surface, either 100% PVC cards or composite cards 
with a PVC surface. Cards can have with a magnetic stripe on one side of the 
card.

Pre-Punched Cards 

For best results, punch cards after 
printing them. The cards can have 
a punched area within 1-inch 
(25mm) of the left-hand edge, as 
the cards are loaded in the printer. 
If the card has a magnetic stripe, 
the card cannot be punched 
anywhere in the stripe.

New Cards for Color Printing

The printer is designed to print on new card stock. If you print on cards twice, be 
careful to avoid getting dirt, fingerprints, or other contamination on cards before 
the second printing. Previous printing can interfere with printing and result in 
cards that do not have the appearance you want. Printing on cards that have been 
issued might introduce substances that interfere with card printing or damage 
the printer. If a previously printed card has been printed with topcoat, the card 
cannot be printed a second time.
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Adhesive Backed Cards

Adhesive-backed cards are printed, and then adhered to proximity cards when 
the card surface is not flat enough to print. The printing surface (white side) of 
adhesive-backed card meets the material requirements for use in some printers. 
Use the following guidelines:

• Store cards in a cool place (such as a refrigerator) to avoid adhesive migration.

• Clean the printer’s card tracks to remove any adhesive residue. Use the 
printhead cleaning pen or isopropanol and a swab to remove the residue.

• Use a print margin of at least 0.05 inch when using adhesive-backed cards.

Card Quality Guidelines
Cards must meet the following card quality guidelines for the printer to print 
high quality graphics on them successfully.

Card Surface

• The card must be free of irregularities such as particles embedded in the 
surface.

• The card surface must be smooth and even. Surface irregularities can cause 
loss of contact, resulting in printing voids.

• The printing surface must be glossy.

• Card edges must be free of raised burrs, which can cause printing voids. This 
is especially true when printing edge-to-edge.

Card Handling

These guidelines apply to unprinted cards.

• Any debris or particles on an unprinted card’s surface can reduce print 
quality and damage the printhead.

• Grease or oils, such as oils from your fingers, also reduce print quality. Keep 
cards completely clean. Do not touch the print surface of a card with your 
fingers or hands.

• Do not use a rubber band to bind blank cards together.

• If you drop a card on the floor, do not insert it into the printer.
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Card Storage

These guidelines apply to both printed and unprinted cards.

• Cards must be stacked so that they will not shift and rub against each other.

• When storing cards, make sure that no two cards contain images or blocks of 
color that will come in contact with each other.

• Make sure that the magnetic stripe on one card does not come in contact with 
the magnetic stripe on another card.

• Make sure that cards with magnetic stripes are stored away from magnets 
and other magnetic objects.

• Store cards in a cool, dry, and dark place. Excessive light can cause yellowing 
of cards on exposed edges.

• Keep cards in their original packaging.

• Cards should be at room temperature when they are used. If cards are stored 
in a cooler environment than the printer, allow them to reach room 
temperature before using.

Replacement Parts
The following replacement parts for use with the printer are available.

Printhead Cartridge

The printer has a replaceable printhead cartridge. The printhead is 
subject to wear or damage and has a direct impact on print quality. 

Do not touch the printing edge of the printhead in the printhead 
cartridge. Clean the printhead following the steps in “Clean the Printhead”.

Print Ribbon Cartridge

The ribbon cartridge holds the print ribbon and the 
replaceable cleaning sleeve in the printer. 
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Cleaning Supplies

The print ribbon kit includes a cleaning card and a replaceable cleaning sleeve. 
For best results, keep additional cleaning supplies on hand.

The following additional cleaning supplies are available:

• Packages of 5 Replaceable Cleaning Sleeves

• Packages of 10 Printer Cleaning Cards.

• A Cleaning Pen: Use the cleaning pen to clean the printhead and other 
internal parts of the printer. A cleaning pen can be used eight times. 

Cleaning Roller Spindle 

The cleaning roller spindle holds the replaceable cleaning sleeve.

Large Output Hopper Option 

The printer can use a large output hopper, which holds 
about 100 cards. The user can replace the small, standard 
hopper with the large hopper without using tools.

Lock Option

The printer can be used with a cable lock. Obtain the lock from your dealer, 
because it includes an added security plate.

Power Supply 

The power supply is rated at 100-240 VAC, 50-60 Hz and 
uses up to 3 amps. It is self-adjusting within the rated input 
voltage.

200-Card Input Hopper

The 200-card input hopper kit includes the larger hopper with cover attached. 
The standard hopper is easily removed and the 200-card hopper can be installed 
without using tools.
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Cables used with the Printer
The printer uses a data cable and a power cable.

Data Cable

The data cable connects the printer to the network or PC sending cards. The data 
cable can be:

• USB cable

• Network cable

USB Cable

Use a USB data cable, 6 feet (2 meters) long, to connect the 
printer to the PC. Be sure to use a cable rated for USB 2.0 
data transmission. 

Network Cable

Use a standard network cable, sometimes called a Category 5 or Cat 5 cable, to 
connect the printer to a network port.

Smart Card Cable

Use a USB cable up to a maximum of 6 feet (2 meters) long to connect the smart 
card port to the PC.

Power Cable

The power cable connects to facility power and the printer power supply. Be sure 
to use a cable that grounds to the facility power source.

The printer can use one of the following power cords:

• USA power cable 

• European power cable

• Australian power cable

• United Kingdom power cable

• Danish power cable

• Indian power cable

• Israeli power cable

• Italian power cable

• Swiss power cable
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• Chinese power cable

• Japanese power cable

HINTS & TIPS

• Use only one data cable with a printer.

• If you need to connect more than one PC to a printer, use a network 
connection.
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Chapter 12: How-To Topics
• “Install a Large Output Hopper” 

• “Install the 200-Card Input Hopper”

• “Install the Lock Option”

• “Adjust the Colors Printed” 

• “View Card Counts using the Driver” 

• “View Card Counts from the Printer LCD Menu” 

• “Change a Card Design” 

• “Run a Cleaning Card” 

• “Clean the Printhead” 

• “Set the Driver Network Port Value” 

• “Encode Magnetic Stripe without Printing” 

• “Change the LCD Backlight” 

• “Get the Printer Network IP Address” 

• “Get the Printer USB IP Address” 

• “Load Cards” 

• “Load Ribbon” 

• “Open Printing Preferences” 

• “Open the Printer Manager” 

• “Open Printer Properties” 

• “Print Driver Sample Cards” 

• “Print a Printer Test Card” 

• “Print on Both Sides of the Card” 
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• “Rotate the Card” 

• “View Printer Status” 

• “Find the Printer Serial Number” 

• “Set Magnetic Stripe Coercivity” 

• “Set the Print Area” 

• “Set IP Address Type” 

• “Use Print Blocking Escapes” 

• “Use Magnetic Stripe Escapes” 

• “Use Magnetic Stripe Fonts” 

• “View the Driver Version” 

• “View Network Information”

• “Print More Than One Copy of a Card” 

• “Set the Print Resolution”

• “Print Bar Codes Using Monochrome”
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Install a Large Output Hopper
The output hopper included with 
the printer holds about 25 cards. 
The printer can be used with an 
optional large output hopper that 
holds up to 100 cards. 

The large output hopper kit 
includes two base sections and a 
large output hopper. The two base 
sections are the same; turn them 
back to back to use them. Each base has hooks, marked by green circles, to attach 
it to the printer base.

You can remove the standard hopper and attach the large output hopper without 
using tools. 

Follow the steps in this topic to attach the 
printer to the bases, and to install the larger 
output hopper. 

1. Position one base section with the open end 
facing the back of the printer.

2. Lift the printer over the base section. 

3. Align the tabs in the base with the slots in 
the bottom of the printer.

4. Push up (a) to insert the four tabs in the slots and then 
push the base forward (b) to lock it to the printer. 

5. Position the other base section with the opening to the 
front of the printer.
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6. Push up (a) to insert the four tabs 
in the slots and then push the base 
back (b) to lock it to the printer. 

7. Remove the 25-card output hopper 
from the printer. Slide it out, 
similar to a drawer. 

8. Slide the 100-card output hopper 
into the assembled base and printer. Make sure the tabs 
(in circles) secure the hopper to the printer. 

HINTS & TIPS

• The base sections contain drawers, useful for holding 
cards, cleaning pen, or other frequently-used items. The 
drawers can be opened from the left or right side of the 
printer.

• The base and large output hopper remain attached 
when the printer is moved or carried.

Install the 200-Card Input Hopper
The standard input hopper can hold about 100 cards. Some printers can be 
upgraded to use a 200-card input hopper. 

The 200-card input hopper kit includes the larger hopper with cover attached. 
The standard hopper is easily removed and the 200-card hopper can be installed 
without using tools. 

1. Open the input hopper. 

2. Press the release tab located on the back 
wall of the hopper while lifting the hopper 
up and off the printer. 

3. Install the 200-Card input hopper by 
aligning the tabs with the slots on the 
printer. 

4. Push the hopper down until it clicks into 
place.
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5. Load up to 200 cards in the hopper and close the cover. The printer is ready to 
print cards. 

Install the Lock Option
The lock option is a user-installed feature that does not require special tools to 
install. The package contains a Kensington® Lock with keys, instructions, and a 
metal security plate. The security plate is installed in the printer and is designed 
to accommodate the T-bar of the Kensington lock.

1. Prepare the printer by installing the 
metal security plate and then follow the 
instructions included in the packaging. 

2. The security plate receptacle is located 
on the underside of the printer towards 
the back left-hand side.

3. Insert the security plate into the 
receptacle with the open end toward 
the printer.

4. Follow the instructions included with 
the lock to complete the installation.
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Adjust the Colors Printed
 The XPS Card Printer driver for use with Windows operating systems includes a 
Color Adjustment feature in Printing Preferences. 

Using the Color Adjustment tab, you can:

• Change the brightness of color printing on the card

• Change the contrast of color printing on the card

• Change the color balance of color printing on the card

1. Open the Preferences dialog in the 
following ways: 

A. Using the Open Printers Window 
button in My XPS Card Printer

B. From the Start Menu in Windows 7 
or Vista

C. From the Start Menu in Windows 
XP

2. Click the Color Adjustment tab to view 
it.

3. The tab contains two similar images: the original image and the adjusted 
image. They show how the changes might look on a card.

4. Check Enable Color Adjustment if needed to use the settings.

Brightness

To change the overall lightness or darkness 
of the card, change the Brightness setting. 

1. Click the Up arrow to make the image 
lighter, or the Down arrow to make the 
image darker.

2. The Adjusted image shows the effect of 
the new setting.

3. Click the Apply button after each 
change to save it. 

4. Print one or more cards to verify your changes:

5. Print one or more cards from the ID software.

6. Print a sample card from the Properties Status page.
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7. Evaluate the appearance of the cards. 

8. Repeat these steps until the cards meet your requirements.

9. Click the Apply button to save the new values. 

Contrast

To change the degree of difference 
between the light and dark values of an 
image, change the Contrast setting.  

1. Click the Up arrow to increase 
contrast, or the Down arrow to 
decrease contrast.

2. The Adjusted image shows the effect 
of the new setting.

3. Click the Apply button after each 
change to save it. 

4. Print one or more cards to verify your changes:

5. Print one or more cards from the ID software.

6. Print a sample card from the Properties Status page.

7. Evaluate the appearance of the cards. 

8. Repeat these steps until the cards meet your requirements.

9. Click the Apply button to save the new values. 

Color Balance

Before you use color adjustment, read and understand the “Color Printing” 
topic.

1. Evaluate the image for color balance. Does the card have a yellow cast or do 
photos have a greenish tint?

If most of the card prints with the correct colors, consider using a graphics 
application to change the logo or other part of the card that needs color 
improvement.
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2. Determine which color needs 
adjustment:

• Increase red, or decrease red to 
add cyan (light blue).

• Increase green, or decrease green 
to add magenta (red-purple).

• Increase blue, or decrease blue to 
add yellow.

• If changing the obvious color does 
not produce the desired effect, try 
changing the other two.

3. Click the Up arrow to increase a color, 
or the Down arrow to decrease 
contrast.

4. The Adjusted image shows the effect 
of the new setting.

5. Click the Apply button after each change to save it. 

6. Print one or more cards to verify your changes:

A. Print one or more cards from the ID software.

B. Print a sample card from the Properties Status page.

7. Evaluate the appearance of the cards. 

8. Repeat these steps until the cards meet your requirements.

9. Click the Apply button to save the new values.

HINTS & TIPS

• The settings on the Color Adjustment page affect the color printing of all 
cards sent from the PC using the driver. 

• Printing formatted as black (K) is not affected by color adjustment. 

• Each click changes the setting by 1 percent (%).

• If you use adjusted colors on some cards, you can uncheck Enable Color 
Adjustment for those that do not need the adjustment.
156 How-To Topics



 

View Card Counts using the Driver
The XPS Card Printer Driver displays card counts in the Printer Properties dialog. 
Follow the steps in this topic to view card counts using the XPS Card Printer 
Driver.

1. Open the Printer Properties dialog. 

2. Click the Card Counts tab. 

3. The Printer Properties shows current 
and total counts.

4. Click the Ask Printer for Update 
button to see the counts if additional 
cards have printed.

About Card Counts:

• Total counts are all the cards the 
printer has processed.

• Current counts are all cards since the 
last time the count was reset. Current 
counts are resettable by the printer manager.

• The printer only sends updated card counts when you click the Ask Printer 
for Update button.

• The printer includes cards picked for test cards and cleaning cards in the 
Cards Picked count, but not in Cards Completed count.

• Card counts cannot be viewed from a shared Client PC.
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View Card Counts from the Printer LCD Menu
The printer front panel has an LCD menu system that displays information about 
the printer, including card counts. See “Use the Front Panel” for information on 
all the LCD menu system.

1. Begin with the printer powered on and in the “Ready” state. 

2. Press the USER button. The LCD panel display shows “suspended”.

3. Press the ENTER key to enter the menu system.

4. Press an arrow key to display “Status” on line 2 of the LCD panel. 

5. Press the ENTER key to enter the Status menu. 

6. Press an arrow key to display “Card Counters” on Line 2. 

7. Press the ENTER key to display “Card Count” on Line 2. 

8. Press the ENTER key to view the total number of cards picked on this printer.

9. Press the ENTER key to display “Cycle Count” on line 2. 

• A cycle is one pass of the printhead. 

• With monochrome (K) ribbon, one cycle prints the front of the card. A 
second cycle might print the back of the card. 

• With YMCKT ribbon, each color panel and topcoat panel uses one print 
cycle. 
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10. Press the ENTER key to view the cycle count. 

11. Press the ENTER key to display “Completed Card” on Line 2. 

12. Press the ENTER key to view the Completed Cards count. 

13. Press the ENTER key to display “Rejected Cards” on Line 2. 

14. Press the ENTER key to display the Rejected Cards count.

15. Press the ENTER key to display to display “Lost Cards” on Line 2. 

16. Press the ENTER key to display the Lost Cards count. 

17. Press the ENTER key to display “Exit” on Line 2.

18. To print cards, press the ENTER key repeatedly to return to the “Suspended / 
Menu Available” display. 

19. Press the USER button to display “Ready” on the LCD panel.

Change a Card Design
Card design is the name given to the combined features of the printed cards. See 
“Card Design and Setup” for more information.

An organization can change:

• The arrangement of card components, such as moving a photo from the center 
to the left side of the card

• The source for card components, such as using a different camera for taking 
photos, or using a new file for a logo.

• The components on the card, such as adding magnetic stripe, logo, or bar 
code.

Whenever the card design changes, review the settings used for the card. Use this 
checklist to guide your changes. Always:

• Use high quality (300dpi) photos and graphics.

• Print several samples of the updated card design.
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• Use cards with a magnetic stripe or bar code in a reader to verify the data 
works as expected. 

• If you print large groups of cards (batches), print a typical group of cards and 
check cards printed at the beginning, middle, and end to make sure they all 
work.

If changing:

• A graphic (logo) on the card 

• The camera for taking photos 

• The location for taking photos 

Then:

• Check the Color Adjustment setting. 

• See “Color Printing” for information about how to improve the 
appearance on one element on a card.

If changing:

• A bar code 

• A magnetic stripe

Then:

• See “Monochrome Printing” if printing bar codes.

• See Magnetic Stripe if adding or changing a magnetic stripe.

• Print several samples of the updated card design.

• Use the cards in a reader to verify the data works as expected.
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Run a Cleaning Card
Run a printer cleaning card to clean debris from the inside of 
the printer. The cleaning card can remove most contaminants 
from the printer. 

1. Begin with the printer powered on. 

2. Open the printer cover and remove the print ribbon 
cartridge.

3. Close the cover. The Ribbon Light will blink rapidly.

4. Open the input hopper and remove unprinted cards. The 
Card light will blink rapidly if the printer has the Card 
Present option.

5. Begin with the printer “Ready”. The USER button shows 
steady green.

6. Press the USER button to display “Suspended” on Line 1 
of the LCD panel. 

7. Press the ENTER key to enter the menu system.

8. Press the ENTER key to enter the Maintenance menu.

9. Press the ENTER key to choose Cleaning Card.

10. With Cleaning Card displayed on Line 2, press the ENTER 
key to display Start on Line 2.

11. Press the ENTER key to display “Insert Cleaning Card” in 
the LCD panel. The USER button and the Card light blink.

12. Open the cleaning card package. 

Place the cleaning card in the input area and press the 
USER button to start the cleaning cycle.

The printer moves the card through the printer several 
times and ejects it in the output stacker. 

13. Remove the used cleaning card. Wait a few minutes for 
the rollers to dry.

14. Replace the cards in the input hopper.

15. Replace the cleaning sleeve with a new sleeve, and 
remove the protective cover. 
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16. Replace the ribbon cartridge and close the printer. The printer is ready to 
print cards again.

17. Discard the used cleaning card and cleaning sleeve.

Clean the Printhead
1. Begin with the printer powered off.

2. Open the printer cover and remove the print ribbon 
cartridge.

3. Open the cleaning pen.

4. Using gentle pressure, move the cleaning pen back 
and forth along the full length of the printhead edge 
until it is completely clean.

5. Replace the print ribbon cartridge and close the 
printer cover. 

6. Power on the printer.

7. Print a sample card to verify the quality of 
printing.

HINTS & TIPS

• Avoid touching the printhead edge with your 
fingers. 

• Avoid touching the printing edge of the printhead 
cartridge with any sharp objects which can 
permanently damage the printhead. 

• Only use the cleaning pen to clean the 
printhead. Other materials can stick to the 
printhead. 

• Use the cleaning pen up to 8 times, and then 
replace it.
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Set the Driver Network Port Value
The XPS Card Printer Driver uses the Printer IP Address to communicate with the 
printer when using a network connection. Follow these steps to view or change 
the IP Address that the driver uses.

1. If needed, obtain the printer IP 
Address. See “Get the Printer 
Network IP Address”. 

2. Open Printer Properties. See “Open 
Printer Properties”. 

3. Click the Ports tab.

4. Locate the DXPnn Standard TCP/IP 
Port for this printer.

5. Click the Configure Port button to 
open the Enter Network Address 
(XP and Vista) or Configure Port 
(Windows 7) dialog.

6. The Printer Name or IP Address 
shows the current IP Address of the 
printer (if assigned). 

7. Enter the current IP Address if 
needed. 

8. Click Apply or Close to close the 
Ports dialog.

• Print a sample card from the 
driver to confirm printer and 
driver communication. See 
“Print Driver Sample Cards”.

9. Click OK or Close to close the 
Properties dialog when done.

HINTS & TIPS

The IP address can change when the printer is powered off and powered on, and 
the Address Method is DHCP. If the IP Address method is Static, then the IP 
Address is assigned using the printer LCD panel and the address does not 
change. 
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If the printer changes address often and that causes problems, ask your manager 
or network support person to assign a printer name, and enter the printer name 
using these steps. See “Set IP Address Type”.

The Ports tab shows the Windows “Enable Printer Pooling” checkbox. The XPS 
Card Printer driver does not support pooling.

The Ports dialog shows the RAW port as 9100. The dialog allows you to change 
the port number but port 9100 is always used.

Encode Magnetic Stripe without Printing
Using the XPS Card Printer Driver, you can use the printer to encode magstripe 
data on a card without printing on it. If you are using ID software to produce 
cards, these steps are not necessary and you can use the settings in the software to 
encode without printing.

1. Open Printing Preferences. See “Open 
Printing Preferences” for the steps to follow. 

2. On the Layout tab, click the Advanced button. 

3. Click the Encode Only choice and choose 
“On” as the setting. Skip this step if you are 
using ID Software.

4. Click OK to save the setting and close the 
Advanced page, and then click Apply on the 
Layout page.

5. The driver discards all printable data and 
sends only the magnetic stripe data to the 
printer. 

6. Format the data:

• If using ID software, use a magnetic 
stripe field if available.

• Using other PC software, format the data 
using magstripe fonts or magstripe 
escapes. 

• The card shown has the text “Sports Arts” formatted with a magstripe 
font. It will be sent as encoded data. The other images and text on Page 1 
will be discarded.

7. Send the card to the printer.
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HINTS & TIPS

• In a PC application, use only one page if sending Encode Only data. A two-
page document will cause an error and the card will not be encoded.

• See How“Use Magnetic Stripe Fonts” for information on formatting data 
using fonts.

• See “Use Magnetic Stripe Escapes” for information on using escapes to 
format data. 

• You are responsible for using characters supported by the track format. The 
driver discards line returns before and after data.

Change the LCD Backlight
Begin with the printer “Ready”. The USER button shows 
steady green.

1. Press the USER button to display “Suspended” on Line 1 of 
the LCD panel. 

2. Press the ENTER key to enter the menu system.

3. Press the down arrow key to scroll to the Configuration 
menu.

4. Press the ENTER key to enter the Configuration menu. 
LCD Backlight is the first choice on the menu.

5. Press ENTER to change the LCD Backlight.

6. Press the down arrow key to lower the light level, or press 
the up arrow key to increase the level.

7. When the light is the level you want, press the ENTER key. 
The printer saves the setting and returns to the 
Configuration menu. 

8. Press an arrow key repeatedly to display “Exit” on line 2.

9. With “Exit” displayed on Line 2, press the ENTER key 
repeatedly to exit the menu system. 

10. With “Suspended” displayed on Line 1, press the USER 
key.

11. The printer is ready.
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Get the Printer Network IP Address
The printer can display the IP address it uses when 
connected to the network. It also displays the Subnet 
Mask, Gateway Address, and MAC Address.

1. Begin with the printer power connected, and the 
printer connected to the network.

2. Press the POWER button (if needed) to power on the 
printer.

3. Press the USER button to suspend the printer. 

4. Press the ENTER button to enter the menu system. 

5. Press the down arrow to display “Status” on line 2.

6. Press ENTER to enter the Status menu.

7. Press the Down Arrow to display Network Status on 
line 2.

8. Press ENTER to display the Network Status menu. 

9. Press the Down Arrow to display “IP Address” on line 
2.

10. Press ENTER to display the IP Address. Record the IP 
Address.

11. Press ENTER to return to the Network menu. Subnet 
Mask is displayed on line 2.

12. If all you need is the IP address, skip to step 18.

13. Press ENTER to display the Subnet Mask value.

14. Press ENTER to return to the Network menu. Gateway 
Addr is displayed on line 2.

15. Press ENTER to display the Gateway Address (if any).

16. Press ENTER to return to the Network menu.

17. Press the Down Arrow to scroll to Exit on line 2.

18. Press ENTER repeatedly until “Ready” is displayed on 
line one and the USER button glows green.   
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Get the Printer USB IP Address
Follow these steps if the printer is connected using a USB cable and you want to 
use the Printer Manager. 

1. Begin with the printer power connected, and the 
printer connected to the PC using a USB cable.

2. Press the POWER button (if needed) to power on the 
printer.

3. When the printer is ready, press the USER button to 
suspend the printer. 

4. Press the ENTER button to enter the menus. 

5. Press the down arrow to display “Status” on line 2.

6. Press ENTER to enter the Status menu.

7. Press the down arrow to display USB IP Address on 
line 2.

8. Press ENTER to display the USB IP Address. 

9. Press the down arrow repeatedly to display Exit on 
line 2.

10. Press ENTER repeatedly to exit the menu system. The 
LCD panel displays Suspended. 

11. Press the USER button to display “Ready” on the LCD 
panel.

12. The printer is ready.
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Load Cards
If you are using a manual feed printer, keep a supply of blank cards close to the 
printer.

For printers with an input hopper, continue with these steps:

1. Open the input hopper (a).  

2. Fan cards before placing 
them into input hopper (b). 

3. Insert magnetic stripe cards 
with the stripe down and 
toward the right-hand side 
of the input hopper. 

4. Close input hopper (c). 

Load Ribbon
Load the ribbon when you install the printer 
and when the ribbon runs out. 

1. Open the printer’s top cover.

2. Remove the print ribbon cartridge.
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3. Load a full roll of print ribbon onto the 
spindle closest to the cartridge handle.

4. Place the empty spool on the spindle 
with the black gear. 

5. Wind the empty spool counter-
clockwise one full turn. 

Load Cleaning Roller
Load a new cleaning roller with each 
new roll of print ribbon.

The printer ships with the cleaning 
roller spindle installed on the print 
ribbon cartridge.

1. Remove the cleaning roller 
spindle from the ribbon cartridge 
and slide the continuous cleaning 
sleeve onto the spindle (a). 

2. Snap the spindle with sleeve 
installed back onto the ribbon cartridge (b). 

3. Remove the protective wrapper from the cleaning sleeve (c). 

Install Ribbon Cartridge
Install the assembled print ribbon 
cartridge into the printer.

1. Hold the print ribbon cartridge by the 
handle and lower into the printer 
with the handle toward the front of 
the printer. 

2. Check to see that the ribbon cartridge 
is correctly positioned in the guides. 
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3. Close the printer cover. 

Open Printing Preferences
You can open the Printing Preferences dialog in the following ways:

• Using the Open Printers Window button in My XPS Card Printer

• From the Start Menu in Windows 7 or Vista

• From the Start Menu in Windows XP

Open Preferences from My XPS Card Printer

1. Open My XPS Card Printer from 
the desktop icon.

2. Click the Open Printers Window 
choice.

3. On the Printers Window, right-click 
the icon for the printer to select it.

4. Choose Preferences from the Pop-
up Menu.

5. The Printing Preferences dialog 
opens. 
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Open Preferences from the Start Menu in 
Windows 7 or Vista

1. From the Windows Start menu, choose 
Control Panel.

2. Click the Hardware (Printers) choice to 
open the Printers Window.

3. Right-click the icon for the printer to 
select it.

4. Choose Printing Preferences from the 
Pop-up Menu.

5. The Printing Preferences dialog opens.

Open Preferences from the Start Menu in 
Windows XP

1. From the Windows Start menu, choose 
Printers and Faxes to open the Printers 
Window.

2. On the Printers Window, right-click the 
icon for the printer to select it.

3. Choose Preferences from the Pop-up 
Menu.

4. The Printing Preferences dialog opens.

HINTS & TIPS

• To save a setting, click the Apply button before moving to another tab. 
Windows discards settings that are not applied.

• The Preferences dialog contains settings that Windows uses to manage your 
card design. The Preferences dialog has the following tabs:

• Layout: See “Print on Both Sides of the Card”

• Layout: See “Print More Than One Copy of a Card”

• Print Area: See “Set the Print Area”

• Print Mode: See “Set the Print Resolution”
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• Color Adjustment: See “Adjust the Colors Printed”

• About: See “View the Driver Version”

• Advanced button: 

• See “Rotate the Card”

• See “Encode Magnetic Stripe without Printing”

• Settings return to default values if the printer name is changed in the Printers 
(and Devices) window.

Open the Printer Manager
The printer includes the Printer Manager, which displays information about the 
printer. The manager or installer uses it to set up the magnetic stripe option and 
to work with your service provider when troubleshooting problems.

1. Get the printer IP Address:

• For a network connection, see “Get the Printer Network IP Address”.

• For a USB connection, see “Get the Printer USB IP Address”.

2. Open the Web Browser on the PC. 

3. In the Address area of the browser, type the following:

http://printer IP address 

For example: http://123.1.23.123 where 123.1.23.123 is replaced by the printer 
IP address.
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4. Press the ENTER key. 

5. In the Please Log In: 
area, enter the 
Username and 
Password. 

• The default 
Username is 
WebUser.

• The default name 
does not require a 
password.

• Your printer might require a password.

6. Click the Log In button.

7. The Welcome to Printer Manager page appears. 

8. Choose the Access Level that matches your job responsibility and click the 
Enter button.

9. The Printer Manager confirms your request and displays the menu.

HINTS & TIPS

• The access level controls the information displayed and the changes that can 
be made. 

• If the Browser cannot connect to the printer, make sure:

• The printer display shows “Ready”.

• Another user does not have a Print Manager session running.

• WebUsers can use the Status menu to view: 

• Printer Status: Choose Status > Printer Status

• Card Counts: Choose Status > Audit Data

• Model, versions and other information about the printer: Choose Status > 
VPD

• The Supplies installed and information about them; Choose Status > 
Supplies.

• For the safest printer, use the Log Out button in Printer Manager and close the 
browser after logging out.
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Open Printer Properties
You can open the Printer Properties dialog in the following ways:

• Using the Open Printers Window button in My XPS Card Printer

• From the Start Menu in Windows 7 or Vista

• From the Start Menu in Windows XP

HINTS & TIPS

The Printer Properties dialog contains settings and values that Windows uses to 
communicate with and manage the printer. The Printer Properties dialog has the 
following tabs:

• General

• Ports (See “Communication with the Printer”)

• Sharing (See “Printer Sharing”)

• Advanced

• Color management (See “Adjust the Colors Printed”

• Security (See “Printer Permissions”)

• Device settings

• Printer Status (See “View Printer Status”)

• Card Counts (See “View Card Counts using the Driver”)

• About
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Open Printer Properties from My XPS Card Printer

1. Open My XPS Card Printer from 
the desktop icon.

2. Click the Open Printers Window 
choice.

3. On the Printers Window, right-
click the icon for the printer to 
select it.

4. Choose Printer Properties from the 
Pop-up Menu.

5. The printer Properties dialog 
opens.

Open Printer Properties from the Start Menu in Windows 7 or Vista

1. From the Windows Start menu, choose 
Control Panel.

2. Click the Hardware (Printers) choice to 
open the Printers Window.

3. On the Printers Window, right-click the 
icon for the printer to select it.

4. Choose Properties from the Pop-up 
Menu.

5. The printer Properties dialog opens.

HINTS & TIPS

Windows 7 includes a priority feature, 
where 1 is low priority and 99 is high 
priority. If you have multiple users, or 
submit multiple cards at about the same 
time, this Windows feature does not override the timing of jobs or the order of 
jobs in the printer. As a result, higher priority cards might print after lower 
priority cards.

Windows 7 includes a Keep printed documents choice on the Printer Properties 
Advanced tab. The XPS Card Printer Driver does not support this setting.
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Open Printer Properties from the Start Menu in Windows XP

1. From the Windows Start menu, 
choose Printer and Faxes to open the 
Printers Window. 

2. On the Printers Window, right-click 
the icon for the printer to select it.

3. Choose Properties from the Pop-up 
Menu.

4. The printer Properties dialog opens.

Printer Permissions

The Windows operating systems include 
security settings. A user with 
Administrator (Windows XP) or 
Creator/Owner (Vista and Windows 7) 
access rights uses them to give or limit 
access for users to the printer.

If the PC to which the printer is attached has more than one user, set permissions 
that:

• Give users access to all features of the printer and driver, including messages. 

• Messages inform users when they need to change the ribbon, load cards, or 
fix problems.

• Prevent any access to the printer by unauthorized users.

To Set Printer Permissions

1. Login to the PC as the Creator/Owner (Vista and Windows 7) or with 
Administrator permissions (Windows XP).

2. Open Printer Properties. See “Open Printer Properties”.

3. Choose the Security tab.

A. Review the Group or User Names list. If the names for which you want to 
specify permissions do not appear in the list, add the names.

B. Choose the Add button to open the Users and Groups dialog box.

C. Click on the name and click Add. Repeat for each name to add.

4. When done adding names, click OK. The Users and Groups dialog box closes.

5. In the Names list, select the name for which you want to specify permissions.
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6. From the Permissions list, select the access:

A. To enable printing, select Allow for Print, Manage Printers, and Manage 
Documents.

B. For a user who should not print to the card printer, select Deny for all 
permissions.

C. Select Apply to save the change. Save changes for each name.

7. Repeat steps 5 and 6 to add other users or groups.

8. Select OK to close the Printer Properties dialog box.

Print Driver Sample Cards
The XPS Card Printer Driver includes a sample card, which shows a basic ID card. 
The card can be printed with any ribbon the printer supports.

The driver also includes a magnetic stripe test 
card, available when the printer includes a 
magnetic stripe option. The card has the same 
data printed on it and encoded on the magnetic 
stripe. 

1. Open Printer Properties. See “Open Printer 
Properties”. 

2. Click the Status tab.

3. The Status tab shows the printer status. The 
printer should be “Ready” or “Busy”. If the 
printer is not available, troubleshoot the problem.

4. Click the button for the card you 
want:

• Print Sample Card button

• Print Mag Stripe Test Card 
button

5. The printer picks the card and prints 
it. If the card does not print, 
troubleshoot the problem.
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HINTS & TIPS

• The sample card verifies communication between the driver and the printer. 
The images and text do not change. 

• The magnetic stripe test card verifies that the driver sends magnetic stripe 
data to the printer and that the printer encodes it. The data cannot be 
changed. 

• The magnetic stripe data sent by the driver requires that the printer be set to 
encode the three-track ISO format for a three-track module, or the JIS-II 
format for the single-track module.

• The sample card buttons will print one copy of the selected card. The Number 
of Copies entry on the Printing Preferences > Advanced page does not apply 
to the sample cards. 

Print a Printer Test Card
The printer includes a test card that runs without using a driver or other source of 
card data. Use it to verify that the printer is working.

1. Begin with the printer “Ready”. The USER button 
shows steady green.

2. Press the USER button to display “Suspended” on Line 
1 of the LCD panel. 

3. Press the ENTER key to enter the menu system.

4. Press the ENTER key to enter the Maintenance menu.

5. Press the down arrow key to display “Test Card” on 
line 2. 

6. With Test Card displayed on Line 2, press the ENTER 
key to display “Start” on Line 2. 

7. After the card prints, press the USER button to return 
the printer to Ready.  
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8. After the card prints, press the USER button to return 
the printer to Ready. 

                                                              

Print on Both Sides of the Card
Some printers include an automatic duplex module which automatically turns 
the card to print both sides. Check the configuration label located on the left side 
of the printer to verify if the printer includes a duplex module. See “Printer 
Configuration Label ” for more information. The method for printing on both 
sides depends on the printer model:

• Printers that have a duplex module installed, automatically turn the card to 
print on both sides. 

• Simplex printers support manual duplex printing. The printer prints one side 
of the card, places the card in the card output stacker, and displays a message. 
The card must be turned and inserted into the hopper or manual feed slot to 
print the back of the card.

Using the XPS Card Printer Driver, you can print 
on both sides of the card. Use ID software or 
another PC application to format and save the 
card data.

To set up manual duplex:

1. Open the PC application and select the card 
printer as the current printer.

2. Use the application’s page setup feature:

• Set the paper size to ISO-ID1 2.13 x 3.38 in

• Reduce the margin settings to 0

• Choose the orientation — portrait or landscape
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3. Create the card: 

• Add graphic elements such as a logo or 
background

• Add a photo

• Add text, such as name, address, or ID 
number

• As you add elements, place them on 
page 1 or page 2

4. Open Printing Preferences from the Start menu. See “Open Printing 
Preferences” for the steps to follow.

• On the Layout tab, choose Flip on Short 
Edge for the Print on Both Sides setting. 
Click Apply. The driver uses the “Short 
Edge” setting for both “Flip on Short Edge” 
and “Flip on Long Edge” settings.

5. Put a card in the input hopper or single feed 
slot.

6. Click Print to send the card to the printer.

7. The printer processes the first side of the card.

8. The printed card exits to the output hopper.

9. The Front Panel shows “Insert same 
card side 2 up” and the User and 
Card lights flash. 

10. Pick the card up by the edges and 
turn it over. Insert it under all cards 
in the input hopper and push until 
it drops into place.

11. Press the USER button to complete 
the card. The printer picks the card again and prints the second side.

HINTS & TIPS

The driver uses the “Short Edge” setting for both “Flip on Short Edge” and “Flip 
on Long Edge” settings.
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Print More Than One Copy of a Card
The Layout tab of Printing Preferences contains a Number of Copies entry area 
used for printing several copies of the same card design. You can print from 1 to 
255 copies of the same card.

To print more than one copy

1. If you are using a card design application, set the number of copies in the 
application. The application settings will override the settings in Printing 
Preferences.

2. Open Printing Preferences. See “Open Printing Preferences” for more 
information.

3. On the Layout tab, click the Advanced button.

4. Type the number of copies you want to print in the Number of Copies area. 
You can print from 1 to 255 copies of the same card design.

5. Click the Apply button.

6. Click the OK button to close Printing Preferences.

7. Send the card(s) to print.

Rotate the Card
1. Open Printing Preferences. See “Open 

Printing Preferences” for the steps to follow.

2. On the Layout tab, click the Advanced button. 

3. Click the Rotate 180 selection for the side to 
rotate. Choose On as the setting. 

4. For the card shown, rotate the back so the text 
prints below the magnetic stripe, not on top of 
it.

5. Click Apply to save the setting, and then click 
Close on both the Advanced page and the 
Layout page.

6. Send the card to print. See “Print on Both 
Sides of the Card” for more information.
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View Printer Status
The XPS Card Printer Driver includes 
the Properties Status page, which 
shows the printer status, any messages 
that apply to the printer, and the ribbon 
installed. 

The following types of information are 
available: 

1. Open the Printer Properties dialog. 
See “Open Printer Properties”.

2. Click the Printer Status tab.

3. In the lower left area, the tab shows 
the date and time the information 
was retrieved from the printer.

4. To get the latest information from the printer, click the Ask Printer for 
Update button.

Printer Status

The Icon and Printer Status line show:

Icon Printer Status

                                                            

Ready
The printer is not processing a card.

                                                            

Suspended
The printer was paused, or is processing a card from another PC 
which has an error.

                                                            

Busy
The printer is processing a card or a command, or the printer 
menu system is being used.

                                                            

Message
If the printer has issued a message for a card sent from this PC, 
the message text is displayed.
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Port Type

The Port Type line shows:

• “USB” for a locally connected printer.

• “Network” for a printer connected using a network connection. The line also 
displays the printer IP address.

Printer Information

The Printer Information box shows:

Model Model name of the printer.

Serial Number The serial number, assigned at the factory, of the printer. 

Firmware Version The build version of the firmware currently running in the printer

Option Information

The options or features included in this printer.

Supplies

The Supplies area shows: 

                                                            

Initializing
The printer is powering on.

                                                            

The printer is off, is shutting down, or is not connected.

Icon Printer Status

                                                            

OK
The printer has ribbon, and at least 10% of the roll remains. 
Ribbon remaining shows the estimated percentage of ribbon not 
used. 

                                                            

Low 
The printer has ribbon, and less than 10% of the roll remains. 
Ribbon remaining shows the estimated percentage of ribbon not 
used.

Icon Printer Status
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Test

The Test area shows the Print Sample Card button and the Print Mag Stripe Test 
Card button. See “Print Driver Sample Cards” for more information.

Find the Printer Serial Number
The printer serial number is available from several sources.

• When the printer is powered off, the printer configuration label is the easiest 
way to find the serial number. See “Printer Configuration Label ” for 
information.

• The XPS Card Printer Driver provides the serial number on the Printer 
Properties > Printer Status tab. See “View Printer Status” for more 
information.

• The printer menu system, available from the front panel of the printer, shows 
the printer serial number.

                                                            

Unknown 
The ribbon is missing or is printer is not processing a card. Ribbon 
remaining shows 0% (percent).

                                                            

Ribbon Type
 For supported ribbons, the type of ribbon, such as YMCKT or K, is 
shown. ymcKT is short-panel ribbon. 
If the ribbon is missing or is not a supported ribbon, “Missing” is 
displayed. 

Icon Printer Status
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Viewing the Serial Number from the Front Panel

1. Begin with the printer powered on and in the 
“Ready” state. 

2. Press the USER button. The LCD panel display 
shows “Suspended”.

3. Press the ENTER key to enter the menu system.

4. Press the down arrow to display “Status” on line 2. 

5. Press the ENTER key to enter the Status menu. 

6. Status is displayed on Line 1 and Serial Number is 
displayed on Line 2.

7. Press the ENTER key to show the serial number. 

8. To print cards, press the ENTER key repeatedly until 
“Ready” is displayed on Line 1 and the USER button 
glows green. 

                                                  
185



 

Set Magnetic Stripe Coercivity
The printer setting for coercivity can be changed from the LCD panel, if needed. 
Usually, coercivity is a system-wide decision and does not change.

1. Begin with the printer “Ready”. The USER button 
shows steady green. 

2. Press the USER button to display “Suspended” on 
Line 1 of the LCD panel. 

3. Press the ENTER key to enter the menu system.

4. Press the down arrow key to scroll to the 
Configuration menu.

5. Press the ENTER key to enter the Configuration menu.

6. Press the down arrow key to display “Magstripe” on 
Line 2.

7. Press the ENTER key to enter the menu. “Coercivity” 
is displayed on line 2.

8. Press the ENTER key to enter the Coercivity menu. 
“Coercivity” is displayed on line 1 and the current 
setting is displayed on line 2.

9. Press an Arrow to display the intended coercivity.

10. Press the ENTER key. “Apply” is displayed on line 2.

11. Press the ENTER key to save the value. “Exit” is 
displayed on Line 2.

12. Press ENTER repeatedly to exit the menu system. The 
LCD panel displays “Ready” and the USER button 
glows steady green. 
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Set the Print Area
The XPS Card Printer Driver can prevent printing and topcoat on specific areas of 
the card. By default, the entire side of the card is printed. If your cards include a 
magnetic stripe, a smart card chip, or other area, define the area to block printing.

For custom print areas, see How to Use Blocking Escapes. For standard areas, 
follow these steps:

1. Open Printing Preferences from the Start 
menu. See “Open Printing Preferences” for 
the steps to follow. 

2. Click the Print Area Tab. 

3. For the side of the card with the non-printing 
area, click the “Print and topcoat entire side of 
card except” list and choose the area. 

4. For the example shown, do not print the ISO 
3-Track Magnetic Stripe area on the back of 
the card. (Text shown on the back is 
formatted with a mag stripe font and will be 
encoded.) 

5. Click Apply to save the setting, and then 
click Close.

6. Send the card to print.

The back of the completed card looks like 
this:

                                                            

Notice the narrow white area above and below the magnetic 
stripe. The non-printing area is slightly larger than the 
feature, in this case the magnetic stripe.
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Set the Print Resolution
The card printer can be set to print at standard resolution, high resolution, or a 
combination of resolutions. For example, the black text of a card design can print 
at high resolution while the color images print at standard resolution.

The ability of a printer to support high resolution printing is set at the factory. If 
the printer includes the High Resolution Print option, the available resolutions 
will be listed on the Status tab of Printer Properties.

The print resolution can be set for color images and/or monochrome card 
designs. 

To set the print resolution

1. Open Printing Properties. 

2. Click the Print Mode tab.

3. Choose from the following options:

• Always use standard resolution (300 x 300 dpi)

The Always use standard resolution setting is the default setting. It will 
print all card elements at standard (300 x 300 dpi) resolution.

• Always use best possible resolution

The Always use best possible resolution settings will print the card at the 
highest possible resolution.

• Custom

Selecting the Custom Print Mode allows you to set the resolution of color 
and monochrome printing. The resolution for color and monochrome 
printing can be set independent of one another. The selections are:

• Color:

• 300 x 300

• 300 x 600

• Monochrome:

• 300 x 300

• 300 x 600

• 300 x 1200

The first number is the resolution along the short edge of the card. 
The second value is the resolution along the long edge of the card.
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Set IP Address Type
The Address Mode determines how the network address of the printer is 
assigned. The choices are DHCP and Static IP. 

DHCP stands for “Dynamic Host Configuration Protocol” and means that the 
network assigns the IP Address to the printer. The printer is set to DHCP in the 
factory. See “Get the Printer Network IP Address” if you use DHCP 
addressing.

Static IP means that the IP Address is assigned, usually by your network support 
personnel. If the IP Address is assigned, then the Subnet Mask, and Gateway 
Address are assigned also. 
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1. Obtain the IP Address, Subnet Mask, and 
Gateway Address for each printer before you 
begin this procedure.

2. Begin with the printer “Ready”. The USER 
button glows steady green.

3. Press the USER button to display 
“Suspended” on Line 1 and Menu available 
on Line 2.

4. Press the ENTER key to enter the menu 
system.

“Main Menu” appears on Line 1 and 
“Maintenance” is shown on Line 2

5. Press the down arrow key to scroll to the 
Configuration menu. 

6. Press the ENTER key when “Configuration” 
appears on Line 2. 

7. Press the down arrow key until “DHCP/
Static IP” is displayed on Line 2.

8. Press the ENTER key to enter the DHCP/
Static IP menu.

9. Press an arrow key to scroll to display “Static 
IP” on Line 2.

10. Press the ENTER key to apply the setting.

“Configuration” will be displayed on Line 1 
and “DCHP/Static IP” is displayed on Line 2.

11. Press the down arrow key to display 
“Network” on Line 2.

12. Press the ENTER key and “Network” is displayed on Line 1 and “IP Address” 
on Line 2.

13. Press ENTER and the IP address appears on Line 2.
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14. Enter the assigned address:

• The IP Address has 4 bytes, separated by 
periods. 

• A curser appears under the digit that 
will change.

a. Use the arrow keys to change one 
digit at a time.

b. Use the ENTER key to navigate 
through the address bytes. The 
address byte shows three digits 
when it can be changed and the 
cursor is under the right-most digit.

c. When all four bytes are correct, press 
the ENTER key. 

15.  Repeat Steps 12 through 14 to enter Subnet 
Mask and Gateway Address information. 

16. Press ENTER when finished entering all 
address information. 

17. Press ENTER to Apply/Restart.

18. Press the USER button repeatedly to exit the 
menu system. “Ready” is displayed and the 
USER light glows steady green.
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Use Print Blocking Escapes
TheXPS Card Printer Driver provides two methods to prevent printing and 
topcoat on specific areas of the card. See “Printing and Non-Printing Areas” for 
more information.

By default, the entire side of the card is printed. If your cards include a magnetic 
stripe, a smart card chip, or other area, do not print or apply topcoat to the area. 
You might have other areas, such as a signature panel or hologram, to prevent 
printing and topcoat. 

For magnetic stripe and smart card areas, see “Set the Print Area”. For custom 
areas which you define, use this topic. 

The XPS Card Printer Driver recognizes escape statements to define print areas. 
Escape statements are specific sequences of characters that mark data with a 
special purpose. Areas defined using escapes override driver settings, unless no 
area is defined. The driver provides the following types of escape statements:

• Block print 

• Add topcoat

• Remove topcoat 

About Printing Areas

Using driver settings, you can define one non-printing area per side of the card. If 
the card has more than one area on a side, define both non-printing areas using 
escapes. An escape statement applies to the side of the card where in appears in 
the document.

The syntax or structure of each escape statement is ~XX%n1n2n3n4? 
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• ~ is the beginning of the statement 

• XX represents the type of action –
Block Print, Add Topcoat, or 
Remove Topcoat.

• n1 is the distance from the top of 
the card to the start of the area

• n2 is the distance from the left 
edge of the card to the start the 
area

• n3 is with width of the area 

• n4 is the height of the area

Each area is a square or rectangular 
shape

The card in this example shows the 
dimensions of a three-track magnetic 
stripe area. 

An escape statement can take the place of settings made in Preferences, by 
omitting the dimension values. For example. ~PB%? prevents print blocking on a 
card.

The escape statement can specify more than one area of the same type by placing 
a semicolon (;) character between the sets of values.

Print Blocking

A print blocking escape statement begins with ~PB%

Examples:

~PB%10 10 55 15? Printing is blocked in one area and any print 
blocking set in Preferences is not used.

~PB%10 10 5 5;30.5 45.23 15 15? Printing is blocked in two areas and any 
print blocking set in Preferences is not used.

~PB%? No printing is blocked and any print 
blocking set in Preferences is not used.
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Topcoat Add Statement

The topcoat add statement prints topcoat in the area defined in the statement. 
All other areas of the card do not have topcoat. All full-color printing must be 
covered with topcoat. Use this option with care.

The topcoat add statement begins with ~TA%

Examples:

~TA%0 0 86.5 37? Topcoat is applied to one large area of 
the card and any topcoat setting in 
Preferences are not used.

~TA%16.8 0 37.1 5;30.5 45.23 15 15? Printing is blocked in two areas and any 
topcoat setting in Preferences is not used.

Topcoat Remove

With a topcoat remove escape, the topcoat is omitted in the areas defined by the 
escape. 

• The topcoat remove statement begins with ~TR% 

• Each blocking area is defined as a series of four values (in millimeters) 
separated by a space: top left width height.

• A semicolon (;) is used to separate topcoat rectangles if more than one area is 
specified within the same escape. 

For example: ~TR% rect1top rect1left rect1width rect1height;rect2top rect2left 
rect2width rect2height?

• After the last rectangle, the ? character is used to end the escape sequence.  

Full Card Topcoat Options

• The application can use the string ~TR%? to override the driver preset masks 
and topcoat the entire card side.

• The application can use the string ~TA%? to override the driver preset masks 
and apply no topcoat to the entire card side.

HINTS & TIPS

• Blocking typically extends 0.1 inch beyond the edges of a feature. The 
dimensions listed include the extended blocking region.

• Print several cards using your card design and application to verify that 
printing and topcoat are applied as you intend.
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• If you do not use the driver or ID software, you can use the dimensions 
provided for smart card and magnetic stripe to customize your print and 
topcoat areas. 

• Use ID software, a custom application, or escapes to define custom non-
printing areas for one or more of the following:

• Blocking printing but not topcoat

• Non-standard areas, such as a preprinted logo or a signature panel

• More than one area on the same side of the card
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Use Magnetic Stripe Escapes
The data to encode on a magnetic stripe is entered as text and can look like data to 
print. The XPS Card Printer Driver uses special characters called Escape Codes to 
identify data to encode. Data within escape codes is not printed. The driver 
supports several Escape Code systems to allow easy compatibility with other 
card printers. See “Supported Escape Codes”.

Using Magnetic Stripe Escapes

1. Use ID software or other application to create a card design.

2. Format the text and graphics to print on the card.

3. Choose a location on the card where 
typing the data to encode will not 
affect other card design 
components. 

4. Type the encode data (text) for one 
track. The example shown uses the 
~<track#><Start Sentinel><Data> 
<End Sentinel> syntax.

• The text for track 1 looks like 
this: ~1%Zachary Hamilton 
12345 Finance?

• Press ENTER to end a line. 

5. Repeat Steps 3 and 4 for each track of magnetic stripe data.

• End each line with an ENTER keystroke.

• Do not put data for two tracks on the same line.

• Do not allow text to encode to wrap to another line.

• You can use two or more lines of text for one track. Each line must start 
and end with escape codes. The driver will add (append) lines for the 
same track together.

• Data to encode can be on side 1 (front) or side 2 (back) of the card.

• Do not enter data to print on the same line as data to encode. It will not 
print.

6. With magnetic stripe cards in the printer, send the card to print. 

7. Verify the encoding success by passing the card through a card reader. 
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Supported Escape Codes

The Escape Code defines the track for the data. The data format for each track is 
set in the printer, and you must enter the type of data the format requires. The 
table below shows the default ISO format data, and how the data looks when 
formatted. The syntax column shows the general statement for how the data must 
be provided. For each track there is an example of how the data looks. 

Syntax Track Example Manufacturer

~<track#><data> 1 (IATA) ~1ENCODING WITH ESCAPES Eltron/Zebra

2 (ABA) ~21234567890

3 (TTS) ~31234567890

~<track#>=<data> 1 (IATA) ~1=ENCODING WITH ESCAPES Atlantek

2 (ABA) ~2=1234567890

3 (TTS) ~3=1234567890

~<track#> 
<Start Sentinel> 
<data> <End Sentinel>

1 (IATA) ~1%ENCODING WITH ESCAPES? Datacard HiFX, RP90x, 
and SRxxx; JVC; and 
Fargo
The only Start Sentinel 
permitted for tracks 2 
and 3 is ; (semicolon)

2 (ABA) ~2;1234567890?

3 (TTS) ~3;1234567890

HINTS & TIPS

• The driver recognizes all supported escape codes.

• Use a small font size to shorten lines of text to encode.

• Keep text to print on a different line from text to encode.

• When the driver adds lines of text for the same track, the sequence is 
determined by the application. Test your application with the driver to make 
sure the data is in the correct order.

• Magnetic stripe data sent by the driver is always encoded on side 2 of the 
card.

• Magnetic stripe data will be converted to uppercase (capital) letters if needed. 

• If not-allowed characters are sent within the magnetic stripe data, the printer 
displays a message.
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Use Magnetic Stripe Fonts
The driver provides fonts to format magnetic stripe data. Use these fonts with 
applications such as Microsoft Word that do not usually support magnetic stripe 
data.

1. Use the application’s page setup feature 
to set the paper size to ISO ID-1. Reduce 
the page margins to match the card 
design.

2. Format the text and graphics to print on 
the card.

3. Type the data to encode. 

• Use a small font size to minimize the 
amount of space used for encoded 
data.

• End each line with an ENTER 
keystroke. 

• Do not put data for two tracks on the 
same line. 

• Do not allow text to encode to wrap 
to another line. 

• You can use two or more lines of text 
for one track. Each line must start 
and end with escape codes. The 
driver will add (append) lines for the 
same track together. 

• Data to encode can be on side 1 (front) or side 2 (back) of the card. 

4. Select a line of data and apply one of the 
following fonts:

• Mag Track 1 XPS Card Printer

• Mag Track 2 XPS Card Printer

• Mag Track 3 XPS Card Printer

• Mag Track JIS XPS Card Printer

5. Repeat Step 4 for each line of text to 
encode. 

6. Send the card to print. 
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7. Verify the encoding success by passing the card through a card reader.

HINTS & TIPS

• Do not use character formatting, such as kerning.

• Do not use smart quotes.

• Use an application in which you can enter and save text, and then edit it after 
saving.

• Use a RETURN or ENTER keystroke to end a line. 

• Use a small font size to shorten lines of text to encode.

• Keep text to print on a different line from text to encode.

• When the driver adds lines of text for the same track, the sequence is 
determined by the application. Test your application with the driver to make 
sure the data is in the correct order.

• Magnetic stripe data sent by the driver is always encoded on side 2 of the 
card.

• Magnetic stripe data will be converted to uppercase (capital) letters if needed. 

• If not-allowed characters are sent within the magnetic stripe data, the printer 
displays a message.

• 

View the Driver Version
1. Open Printer Properties. See “Open Printer 

Properties”. 

2. Click the About tab.

3. The About tab shows the driver version. 

4. Click Close to close the Printer Properties 
dialog.

View Network Information
When the printer and PC using the XPS Card Printer Driver are connected using a 
network, the network settings on the PC and the printer must match. 

The driver Printer Properties dialog includes the Ports tab for specifying or 
viewing the printer IP Address being used. See the “Port Type” section of “View 
Printer Status” to view the setting.
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If the printer is set to use DHCP (Dynamic Host Configuration Protocol), the IP 
address of the printer can change when the printer is powered off and then 
powered on. The XPS Card Printer Driver will issue message 500. 

To check the IP address that the printer is using, see “Get the Printer Network 
IP Address”. If the printer IP Address changes often, using Static IP addressing 
might provide a more reliable connection. Work with your network support 
group to identify the IP Address, Subnet Mask and Gateway Address (if used). 
Then, see “Set IP Address Type”.

Print Bar Codes Using Monochrome
The card printer can be set to detect bar codes that could be embedded in an 
image and send the data to print using the K panel of color print ribbon. See 
“Types of Bar Codes Detected” for the type of bar codes that can be detected by 
the driver. For more information on printing bar codes, see “Printing Bar 
Codes”

Set the bar code detection using 
the settings in the Advanced 
Options window of Printing 
Preferences. 

1. Open Printing Preferences. 
See “Open Printing 
Preferences”

2. Click the Advanced button.

3. Set the Print bar codes using 
monochrome to ON.

4. Click OK to close the 
Advanced Options window.

5. Click OK to close Printing 
Preferences.
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Chapter 13: Legal Notices
Safety and Compliance
Please note and heed the WARNING and CAUTION labels that have been 
placed on the equipment for your safety. Please do not attempt to operate or 
repair this equipment without adequate training.

Regulatory Compliance

Notice for USA (FCC notice)

This equipment has been tested and found to be within the limits for Class A 
computing devices, pursuant to Subpart J of Part 15 of FCC rules, designed to 
provide reasonable protection against radio interference in a commercial 
environment. This equipment generates, uses, and can radiate radio frequency 
energy. If it is not installed and used in accordance with this instruction manual, 
it may interfere with radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will 
be required to correct the interference at their own expense.

Changes or modifications not expressly approved by the party responsible for 
compliance could void the user's authority to operate the equipment.

Notice for Canada

This digital apparatus does not exceed the Class A limits for radio noise for 
digital apparatus set out in the Radio Interference Regulations of the Canadian 
Department of Communications.

Le présent appareil numérique n'émet pas de bruits radioélectriques dépassant 
les limites applicables aux classe A prescrites dans le Règlement sur le brouillage 
radioélectrique édicté par le ministère des Communications du Canada.

The term “IC:” before the radio certification number only signifies that Industry 
Canada Technical specifications were met.
201



 

Notice for Europe 

We hereby certify that this printer complies with EMC Directive 89/336/EEC, 
R&TTE Directive 1999/5/EC, and the EU RoHS Directive EU Directive 2002/95/
EG. This printer conforms to Class A of EN 55022 and to EN 301 489-5. Operation 
of this equipment in a residential environment may possibly cause interference. 
In the event of interference, the user, at their own expense, will be required to 
take whatever measures are necessary to correct the problem.

Notice for Taiwan 
                                                            

Notice for Japan

This equipment is in the Class A category of information technology equipment 
based on the rules of the Voluntary Control Council for Interference by 
Information Technology Equipment (VCCI). When used in a residential area, 
radio interference may be caused. In this case, the user may be required to take 
appropriate corrective actions.

Notice to All Users
The printer emits radio-frequency waves and must be used as installed and 
recommended by the printer manufacturer. You may not modify the printer or 
how it is used without written permission. You may not operate the printer after 
modifying it or its method of operation.
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Liability Statement
This product has been built to the high standards of ScreenCheck. Please note and 
heed the WARNING and CAUTION labels that have been placed on the 
equipment for your safety. Please do not attempt to operate or repair this 
equipment without adequate training. Any use, operation or repair in 
contravention of this document is at your own risk. By acceptance of this system 
you hereby assume all liability consequent to your use or misuse of this 
equipment. ScreenCheck assumes no liability for incidental, special, or 
consequential damage of any kind. Equipment specifications, applications and 
options are subject to change at the sole discretion of ScreenCheck without notice.

Safety
All Datacard Group brand products are built to strict safety and reliability 
specifications in accordance with UL60950 and Canadian requirements, and the 
Low Voltage Directive 73/23/EEC. Therefore, safety issues pertaining to 
operation and repair of Datacard Group brand equipment are primarily 
environmental and human interface.

The following basic safety tips are given to ensure safe installation, operation and 
maintenance of Datacard Group brand equipment and are not to be considered as 
comprehensive on all matters of safety.

Safe environment

Connect equipment to a grounded power source. Do not defeat or bypass the 
ground lead. 

Place the equipment on a stable surface (table) and ensure floors in the work area 
are dry and non-slip. 

Know the location of equipment branch circuit interrupters or circuit breakers 
and how to turn them on and off in case of emergency. 

Know the location of fire extinguishers and how to use them. ABC type 
extinguishers may be used on electrical fires. 

Know local procedures for first aid and emergency assistance at the customer 
facility. 

Use adequate lighting at the equipment location. 

Maintain the recommended temperature and humidity range in the equipment 
area. 
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Safe human interface

Use proper lifting techniques when moving or installing the equipment. 

Use standard electrostatic discharge (ESD) precautions when working on or near 
electrical circuits. 

Do not disconnect safety interlocks on covers. Operate the printer with the cover 
closed. 

Acknowledgments
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is a registered trademark of DataCard Corporation in the United States and/or 
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Microsoft, Windows, and Windows Vista are trademarks or registered 
trademarks of Microsoft Corporation.

Photoshop is a registered trademark of Adobe Systems Incorporated.

TrueType, Apple, and Bonjour are registered trademarks of Apple Computer, 
Inc.

Mifare is a registered trademark of Philips Semiconductors Gratkorn GMBH. 

Gemplus is a registered trademark and GemPC is a trademark of Gemplus S.C.A. 
Corporation.

iCLASS and HID are registered trademarks of HID Corporation.

All other trademarks are the property of their respective owners.

Fonts

Portions of the software are copyrighted by Red Hat. To access magnetic stripe 
fonts, download the Windows fonts (liberation-fonts.zip) from 
www.redhat.com/promo/fonts.

The Katakana font used in magnetic stripe fonts is copyright 1990-2003 Wada 
Laboratory, the University of Tokyo. All rights reserved.
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Copyright (c) 2003-2004 Electronic Font Open Laboratory (/efont/). All rights 
reserved.

This font is provided by WADA Laboratory, the University of Tokyo and 
contributors “AS IS” and any express or implied warranties, including, but not 
limited to, the implied warranties of merchantability and fitness for a particular 
purpose are disclaimed. In no event shall the laboratory or contributors be liable 
for any direct, indirect, incidental, special, exemplary, or consequential damages 
(including, but not limited to, procurement of substitute goods or services; loss of 
use, data, or profits; or business interruption) however caused and on any theory 
of liability, whether in contract, strict liability, or tort (including negligence or 
otherwise) arising in any way out of the use of this software, even if advised of 
the possibility of such damage.

Disclaimer
Names and logos on sample cards are fictitious. Any similarity to actual names, 
trademarks, or trade names is coincidental.

Proprietary Notice
All drawings and information herein are the property of DataCard Corporation.
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